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Contacting Support

Further information and technical support are available from Specim, Spectral Imaging Oy Ltd. in Finland. Contact
information:

o WWW: www.specim.fi
*  Email: support@specim.fi
» Tel: +358 (0)10 4244 400

Legal Information

Certification

Specim, Spectral Imaging Ltd has developed Quality Management System for its use covering design, development,
manufacturing, sales and support of optical measurement devices. QMS follows ISO9001:2015 and enables more
efficient operation and product management in a systematic way utilizing metrics. Specim QMS has been audited by
Bureau Veritas Certification Holding SAS — UK Branch and found to be in accordance with the requirements of the
management system standards.

Disclaimer

All information provided in this guide and provided manuals is believed to be complete, accurate and reliable at the
time of delivery. No responsibility is assumed by Specim, Spectral Imaging Oy Ltd. for its use. Specim, Spectral
Imaging Oy Ltd reserves the right to make changes to this information without notice. Reproduction of this manual
in whole or in part, by any means, is prohibited without prior permission having been obtained from Specim, Spectral
Imaging Oy Ltd.

Specim IQ ® and Specim IQ Studio ® are registered EU trademarks (Nos. 016777393 and 016777419) owned by
SPECIM, Spectral Imaging Ltd.

Contacting support

Further information and technical support are available from Specim, Spectral Imaging Oy Ltd. in Finland. Contact
information:

o WWW: www.specim.fi
*  Email: support@specim.fi
» Tel: +358 (0)10 4244 400

Installation

This section will guide you through the installation of the software.

Installing Qt

This section describes how to install Qt.

All Specim applications are built on top of the Qt application framework (see: http://qt-project.org). To minimize the
installer sizes and speedup the update, we provide a shared installer.

The installer is named Specim QtRuntime redist setup 5.4.1.exe.S.4.1is the Qtrevision number.
This information is subject to change if Qt updates are required.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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Proceed as follows:

1. Double-click the Specim QtRuntime redist setup 5.4.1.exe file.

The installation wizard is opened.

;_') 0Qt5 Runtime Libraries Setup

sPecim

SPECTRAL IMAGING

Welcome to the Qt5 Runtime
Libraries Setup Wizard

This wizard will guide you through the installation of QLS
Runitime Libraries,

1t is recommended that you close all other applications

relevant system files without having to reboot your
compuker,

Click Mext to continue.

o] ® s

before starting Setup. This will make it possible to update

Mext = | | Cancel

Figure 1: Qt Installation Wizard
2. Select Next.

The license screen is opened.

;_') Ot Runtime Libraries Setup

sPecim

SPECTRAL IMAGING

License Agreement

Please reviews the license terms before installing GES Runtime
Libraries.

Press Page Down ko see the rest of the agreement.,

fo] ® ]

Specim Specim Imaging Software End User License Agreement

THIS LICENSING AGREEMENT {"AGREEMENT ) IS A LEGAL AGREEMENT
BETWEEN YOQU, EITHER AN INDIVIDUAL OR A SINGLE ENTITY, AND SFECIM
SPECTRAL IMAGING SOFTWARE ("LICENSOR™. IF vOU DO NOT AGREE TO
EACH AND EVERY TERM, YOU ARE TO CLICK "CANCEL™ BUTTOMN AND NOT
TO OPEN, USE OR INSTALL THE 5OFTWARE AND YOU MUST DELETE THE
SOFTWARE FROM YOUR COMPUTER AND/OR ANY OTHER DATA 5STORAGE
DEVICE.

L GENERAL

If vou accept the kerms of the agreement, click I Agree to continue. You must accept the
agreement to install kS Runtime Libraries.

« Back ” 1 Agree ] | Cancel

Figure 2: Qt License Screen
3. Accept the license by selecting I Agree.

The component selection screen is opened.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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sPecim

SPECTRAL IMAGING

Select components to install:

Space required: 159.9MB

;’j 0Qt5 Runtime Libraries Setup

Choose Components
Choose which features of QS Runtime Libraries yaou wank ko

install.

Check the components you want to install and uncheck the components you don't want to
install, Click Install ta start the installation,

o] ® s

Luntime Libr
QES Runtime Libraries - 32bit
E QES Runtime Libraries - 64bit

’ < Back ][ Inskall ] ’ Cancel

Figure 3: Qt Comp

Choose the components to be installed. We recommend using the default settings.

4. Select Install.

onent Selection Screen

The installation progress screen is opened.

sPecim

SPECTRAL IMAGING

Execute: wo2013redist_xs6,

;’j 0Qt5 Runtime Libraries Setup

Installing

Please wait while QS Runtine Libraries is being installed.

exe fg

[=] 3 | =

Extract: QrSiwidgets.dll...

Extract: QreTest.dl,,. 100%
Extract: QtSwebkit.dl... 100%

100%:

Extract: Qrsxml.dll, ., 100%

Extract: QrS¥miPatterns.dl.,.. 100%
Extract: icudt53.dll... 100%

Extract: icuinS3.dl... 100%

Extract: icuucs3.dll... 100%

Extract: vc2013redist_x&6,exe,,, 100%
Execute: ve2013redist_x86.exe g

m

< Back. Mext = Cancel

Figure 4: Qt Install

5. After a successful installation, the wizard prompts you to reboot the computer.

ation Progress Screen

The installer declares some environment variables at the system scope, thus we recommend rebooting the

computer to insure the new settings are properly propagated.

Reboot the computer by selecting the Reboot now radio button and selecting Finish.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;’_'} 0Qt5 Runtime Libraries Setup EI [=1|| -2

SPECIIM  Completing the Qt5 Runtime

A A Libraries Setup Wizard

“our computer must be restarted in order bo complete the
installation of QS Runtime Libraries, Do you wank to rebook;
now?

() Twank to manually reboat: later

< Back Cancel

Figure 5: Completing the Qt Installation

Installing Intel Libraries
This section describes how to install Intel libraries.

The application engine makes use of some Intel optimized libraries. The installer is large in size and the libraries are
shared, so they come as a separate installer.

The installer name is Specim Intel redist setup 1.1.0.exe. The 1.1.0 revision number is subject to
changes.

Proceed as follows:
1. Double-click the Specim Intel redist setup 1.1.0.exe file.

The installation wizard is opened.

;’_'}IntelLibraries Setup EI =] @

SPECIIM  welcome to the Intel Libraries Setup

SPECTRAL IMAGING Wizard

This wizard will quide wou through the installation of Intel
Libraries.

1t is recommended that you close all other applications
before starting Setup, This will make it possible to update
relevant system files withaut having ta rebook waur
cornpuker,

Click Mezxt to continue,

[ oMext> | ’ Cancel

Figure 6: Intel Libraries Installation Wizard
2. Select Next.

The license screen is opened.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;_') Intel Libraries Setup

sPecim

SPECTRAL IMAGING

License Agreement
Please review the license terms before installing Intel Libraries,

Press Page Down ko see the rest of the agreement.

o] ® s

Specim Specim Imaging Software End User License Agreement

THIS LICENSING AGREEMENT ("AGREEMENT™) IS A LEGAL AGREEMENT
BETWEEN YOU, EITHER AN INDIVIDUAL OR A SINGLE ENTITY, AND SPECIM
SPECTRAL IMAGING SOFTWARE ("LICENSOR™). IF YOU DO NOT AGREE TO
EACH AND EVERY TERM, YOU ARE TO CLUICK "CANCEL" BUTTON AND NOT
TO OPEN, USE OR INSTALL THE SOFTWARE AND YOU MUST DELETE THE
SOFTWARE FROM YOUR COMPUTER AND/OR ANY OTHER DATA STORAGE
DEVICE.

L GENERAL i o o .

IF wou accept the berms of the agreement, click I Agree to continue. You must accept the
agreement to install Intel Libraries,

| < Back. |[ 1 Agree ] | Cancel

Figure 7: Intel Libraries License Screen
3. Accept the license by selecting I Agree.

The component selection screen is opened.

;_') Intel Libraries Setup

sPecim

SPECTRAL IMAGING

Chooge Components

“hoose which features of Intel Libraries wou want to install.

Check the components you want ta install and uncheck the components you don't wank ko
install, Click Install ko start the installation.

Select components ko install:

Inkel Libral
kel Libraties - 32bit

Intel Compilers - 32bit

Intel Inteqrated Performance Primitives - =
Intel Math Kermel Library - 32bit

Intel Threading Building Blocks - 32bit

kel Libraties - 64hit

: Intel Cormpilers - 64bit

Space required:; 1.1GE

fo] ® ]

| « Back ” Install | | Cancel

Figure 8: Intel Libraries Component Selection Screen

Choose the components to be installed. We recommend using the default settings.

4. Select Install.

The installation progress screen is opened.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;j Intel Libraries Setup EI [=1|| -2
SPEC"TI Installing

Please wait while Intel Libraries is being installed.
SPECTRAL IMAGING

Extract: ippgenps-5.1.dil
———

Extract: ippdig9-5.1.dll.., 100% -
Extract: ippdihg-g.1.dll.., 100%
Extract: ippdipS-5.1.4ll... 100%:
Extract: ippdipzc-5.1.dll... 100%:
Extract: ippdiva-5.1.dll.., 100%
Extract: ippdiv?-5.1.dll.., 100%
Extract: ippgen-2.1.dll... 100%
Extract: ippgeng3-5.1.dil... 100%
Extract: ippgenhs-5.1.dll.,, 100%
Extract: ippgenps-3.1.dll ils

m

< Back. Mext = Cancel

Figure 9: Intel Libraries Installation Progress Screen
5. After a successful installation, the wizard prompts you to reboot the computer.

The installer declares some environment variables at the system scope, thus we recommend rebooting the
computer to insure the new settings are properly propagated.

Reboot the computer by selecting the Reboot now radio button and selecting Finish.

DInteILibraries Setup EI =23

SPECIIM  Completing the Intel Libraries Setup

SPECTRAL IMAGING Wizard

Your computer musk be restarted in order ko complets the
inskallation of Intel Libraries. Do wou want to reboot now?

) T want to manually reboot later

« Back Cancel

Figure 10: Completing the Intel Libraries Installation

Installing Lumo Recorder
This section describes how to install Lumo Recorder.

The sensor hardware must installed before installing Lumo Recorder, otherwise the paths detection for copying
camera files will fail, and you will not be able to use your sensor.

Proceed as follows:

1. Run the Lumo Recorder installer.

The installation wizard is opened.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;_') Lurna - Recaorder Setup EI =] @
SPECIM  welcome to the Lumo - Recorder

—— Setup Wizard

SPECTRAL IMAGING

This wizard will guide you through the installation of Luma -
Recaorder,

1t is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
compuker,

Click Mext to continue.

[ omMexts | | Carncel

Figure 11: Lumo Recorderinstallation Wizard
2. Select Next.

The license screen is opened.

;_')Lumo—Recorder Setup E = @
SPEC““ License Agreement

Please review the license terms before installing Lumo - Recorder,

SPECTRAL IMAGING

Press Page Down ko see the rest of the agreement.

Specim Specim Imaging Software End User License Agreement i

THIS LICENSING AGREEMENT ("AGREEMENT™) IS A LEGAL AGREEMENT
BETWEEN YOU, EITHER AN INDIVIDUAL OR A SINGLE ENTITY, AND SPECIM
SPECTRAL IMAGING SOFTWARE ("LICENSOR™). IF YOU DO NOT AGREE TO
EACH AND EVERY TERM, YOU ARE TO CLICK "CANCEL" BUTTON AND
NOT TO OPEN, USE OR INSTALL THE SOFTWARE AND YOU MUST DELETE
THE SOFTWARE FROM YOUR COMPUTER AND/OR ANY OTHER DATA
STORAGE DEVICE.

L GENERAL

IF wou accept the berms of the agreement, click I Agree to continue. You must accept the
agreement to install Lumo - Recorder.

| < Back. || 1 Agree | | Cancel

Figure 12: Lumo Recorder License Screen
3. Accept the license by selecting I Agree.

The component selection screen is opened.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;’j Lurna - Recaorder Setup

sPecim

SPECTRAL IMAGING

Choose Components

Choose which features of Lumo - Recordar yaou want ko install,

Check the components you want to install and uncheck the components you don't want to
install, Click Mexkt to continue,

o] ® s

Select components to install:

[ sensor profiles

Space required: 199.2MB

’ < Back ][ Mext = ] ’ Cancel

Figure 13: Lumo Recorder Component Selection Screen

4. Select the components to install and select Next. If you select the Sensor profiles component, the installer will

copy the SSPs to C:\Users\Public\Documents\Specim.

The start menu selection screen is opened.

;’j Lurna - Recaorder Setup

sPecim

SPECTRAL IMAGING

Choose Start Menu Folder
Choose a Start Menu Folder For the Luma - Recordet shortouts,

Select the Start Menu Folder in which you would like to create the program's shortouts, Yoo
can also enker a name ko create a new folder,

7-Zip

Accessaries

ActivePerl 5.14,2 Build 1402 {&4-bit)
Bdministrative Tools

allied Vision Technologies

ASIOGALL w2

AsLIS

Atlassian

Atlassian Connectar For Yisual Studio
Bevond Compare 2

Brother

D Do not create shorkouts

o] ® s

’ < Back ][ Inskall ] ’ Cancel

Figure 14: Lumo Recorder Start Menu Selection Screen
5. Select Install.

The installation progress screen is opened. At the end of the installation, an import setting dialog will be opened.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;’_')Lumo—Recorder Setup EI [=1|| -2

SPEC"TI Installing
— — Please wait while Lurno - Recaorder is being installad.
SPECTRAL IMAGING

Extract: libmwilgn.dil
——

Extract: gxapi.dll,., 100% -
Extract: icude4.dll,,. 100%

Extract: icuin49.dl... 100%

Extract: icuiodd.dll... 100%

Extract: icuuc4d.dil... 100%.

Extract: ipas.dl... 100%

Extract: libexpat.dil... 100%:

Extract: ibrmaMATLAE res.dll... 100%
Extract: lbrmwfl dll.., 100%

Extract: librwilsn,dil

m

< Back. Mext = Cancel

Figure 15: Lumo Recorder Installation Progress Screen

Select Yes to import the settings from the previous installation. It the import fails, please contact Specim's support
(support@specim.fi) and forward error report is created.

The wizard final page is opened.

5 Lumo - Recorder Setup 28

Irmport settings and configuration scripts from previous installed wersion
(14201511517

Figure 16: Lumo Recorder Import Settings Screen
Close the OpenGL Warning Screen.

If your computer does not meet the minimum OpenGL requirements, a message box is opened. Click the OK
button to continue with the installation. You cannot use Lumo Recorder until you install the correct drivers or
install a graphics card with OpenGL 2.0 support, at least.

=9 Lumo - Recorder Setup IEI

Current OpenGL version (LL0O) is below required (2,00, Please upgrade
l W wour graphics drivers,

Figure 17: OpenGL Warning Screen
After a successful installation, the wizard prompts you to reboot the computer.

The installer declares some environment variables at the system scope, thus we recommend rebooting the
computer to insure the new settings are properly propagated.

Reboot the computer by selecting the Reboot now radio button and selecting Finish.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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;’_')Lumo—Recorder Setup EI [=1|| -2

SPEeCIIM  Completing the Lumo - Recorder

—— Setup Wizard

SPECTRAL IMAGING

“our computer must be restarted in order bo complete the
installation of Lumo - Recorder, Do you wank to rebook now?

T want to manually reboat later

< Back Cancel

Figure 18: Completing the Lumo Recorder Installation

About Lumo Recorder

Lumo Recorder is a data recording application for Specim’s spectral cameras and airborne systems.

Lumo Recorder can control HSI and GPS/INS sensors, and store their data onto the computer hard drive. It can also
control other external devices, required for certain sensors, such as thermal calibrator, triggering electronics, motors,
and so on.

Lumo Recorder has a built-in scripting and sequential workflow engine controlling all the steps and automation to
be performed for each measurement.

Thanks to its remote control server, Lumo Recorder can be controlled through Lumo Remote SDK. It allows
integrating Lumo Recorder into other systems, and allows building more sophisticated networks of sensors as in
SisuROCK systems.

If the acquisition computer hardware and performance allow, Lumo Recorder can handle multiple sensors on the same
computer.

If the imaging setup requires multiple sensors, which cannot be installed on the same computer, Lumo Recorder can
be configured to use remote sensors. These remote sensors are controlled using Lumo Remote SDK.

Lumo Recorder offers several options to control the quality of the data (QA4/QC) as part of the standard recording
workflow.

If the recorded dataset must be transferred to another computer, Lumo Recorder has an option to automatically
queue the dataset to Lumo FileTransfer Server.

Minimum requirements

This application is supported on Windows 7 and onward. The computer must meet the following hardware
requirements:

+ Intel Core 2 Duo.

* 4GB of RAM.

» 128GB SSD hard drive or more for the operating system.

» 256GB SSD hard drive or more for each sensor to record the data.
* Graphics card with OpenGL 2.0 support or better.

* 64-bit operating system to allow large file handling.

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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e Screen resolution of 1024 x 800.

Lumo Graphical User Interface

All Lumo applications use the same tabbed interface layout. Each tab categorizes controls and features.

A
Application Name View selector
4 Left pane Content area Right pane |
4 Log window [ 3
v

Figure 19: Lumo Graphical User Interface Layout

The general layout consists of a title bar, left pane, right pane, bottom pane and the content area.

GUI Areas
The GUI areas are:

» Title bar — The title bar contains the application name and the view selector. The name of the active view is
highlighted.

* Left pane and right pane — The left pane and right pane widths can be changed, and are independent for each
view. In other words, each view can have a different width for the panes.

You can change the width by clicking the sliders between the content area and the panes, and sliding them.
* Bottom pane — You can change the bottom pane height by clicking the slider between the view area and the
bottom pane, and sliding it.

The bottom pane height is the same for all the views.
* System tray icon — When enabled in the software, the application can add an icon to the Windows system tray.

Usually, the icon is used to set the application window back to visible, when the Minimize the application to
system tray option is enabled (see Defining the General Parameters).

All rights reserved - Specim, Spectral Imaging Oy Ltd.
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Visibility

The visibility of the title bar and the three panes can be controlled by clicking the areas with the triangle icons.

The triangle above the title bar. The visibility of the title bar is the same for all the views.

The triangle on the left side of the left pane. The visibility of the left pane is independent for each view.
The triangle the right side of the right pane. The visibility of the right pane is independent for each view.
The triangle below the bottom pane. The visibility of the bottom pane is the same for all the views.

The triangles on the left and right side of the log window are not visible, as they are reserved for future use.

Lumo Recorder Views

You can switch between the views by using the View selector, located in the upper right corner of the Title bar.

Lumo Recorder has three views:

The Setup View. Carry out the initial setup-related tasks in the Setup View, see Initial Setup.

The Adjust View. After the intial setup is completed, carry out the sensor adjustments in the Adjust View, see
Adjusting the Sensor.

The Capture View. Once the system is ready, you can operate Lumo Recorder in the Capture View, see Operating
Lumo Recorder.

Setup View

The Setup View has a wizard-like interface, where the initialisation steps are arranged in the execution order. Clicking
a navigation button brings up the desired dialogue. Use the mouse wheel to scroll the dialogues view.
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Figure 20: The Setup View

The Dialog N Headings in Figure 20: The Setup View, also referred to as settings group, are replaced with the

settings group name, such as:

* Dataset

* Remote control server
* Logging

Adjust View

The Adjust View View area contains four sections:

* The Detector Widget.

*  The Waterfall Widget.

» The Spectral Plot Widget.
* The Spatial Plot Widget.

5 Note: The four Widgets display data from the activated sensor only. With multiple sensor setups, a View
button is visible on the upper right corner of the sensor parameters group, located in the left pane. Click the
View button of the corresponding sensor to show its live data in the widgets.
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Detector view Waterfall view

Spectral Plot Spatial plot

Figure 21: The Adjust View View area

Left Pane

When the Adjust View is selected, the left pane contains the following controls:

* Sensor(s) parameters

Right Pane

When the Adjust View is selected, the right pane contains the following controls:

+ Image correction parameters
* Focusing tool
*  QA4/QC parameters

Detector widget
The Detector Widget provides a greyscale image of the incoming frames.

» A dark grey pixel in the image corresponds to a low raw pixel value.
* A white grey pixel in the image corresponds to a large raw pixel value.

The image in the Detector Widget shows the incoming frame as a matrix, where the first pixel coordinate is on the
upper left-hand corner.
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Figure 22: Detector view

The pixels along the X direction refer to the spatial dimension, and the pixels along the w1 direction refer to the
spectral dimension. A detector column represents the entire spectra at a spatial location.

Saturated pixels are shown as bright red. A pixel is considered saturated if its value is equal to the maximum pixel
value.

The Detector Widget is useful to perform tasks, such as:

» Saturation monitoring.

» Image control.

+ Setting the RGB bands.

» Spectral references definition.
» Spatial references definition.
» Focusing.

+ Setting the GUI ROI.

Detector Widget Parameters
The Detector Widget context menu contains the following parameters:

* Zoom in — This parameter allows you to zoom in the image. You can also zoom in by holding the Ctr1 key and
using the mouse scroll button.

* Zoom out — This parameter allows you to zoom out the image. You can also zoom out by holding the Ctr1 key
and using the mouse scroll button.

» Fit to window — This parameter will automatically calculate the zoom level required to fit the entire Detector
Widget image in the parent window, while keeping the aspect ratio.

O Tip: While Fit to window is activated, you cannot Zoom in or Zoom out.
* Show cursor value — When this parameter is enabled, a blue text is displayed in the lower left-hand corner of the
Detector Widget. The text is in the format:

dn:..., X:..., Vi...[...nm]

where

* The dn section displays the raw pixel value under the mouse cursor.
» The x section displays the pixel's x coordinate.

» The y section displays the pixel's y coordinate.

* The nm section displays the corresponding wavelength value.

* Show RGB bands — This parameter controls the visibility of the RGB lines on the Detector Widget. When
enabled, a red, a green and a blue horizontal line is plotted on top of the detector image. The vertical position of
the lines correspond to the wavelength they are set to.

The RGB bands can be changed in the Detector Widget as follows:
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1. Place the mouse cursor on top of a band.

2. Select it by holding the left button of the mouse.
3. Move the band by sliding the mouse up or down.
4. Release the left button of the mouse.

* Show spatial references — This parameter controls the visibility of the spatial reference lines on the Detector
Widget. Spatial references are added from the Detector Widget Options dialog (see Managing References), and
plotted in the Spatial Plot Widget.

The spatial reference indices can be changed in the Detector Widget as follows:

1. Place the mouse cursor on top of a reference line.
2. Select it by holding the left button of the mouse.
3. Move the band by sliding the mouse up or down.
4. Release the left button of the mouse.

* Show spectral references — This parameter controls the visibility of the spectral reference lines on the Detector
Widget. Spectral references are added from the Detector Widget Options dialog (see Managing References), and
plotted in the Spectral Plot Widget.

The spectral references indices can be changed in the Detector Widget as follows:

1. Place the mouse cursor on top of a reference line.
2. Select it by holding the left button of the mouse.
3. Move the band by sliding the mouse left or right.
4. Release the left button of the mouse.
* Select focus region — This parameter allows you to draw a ROI rectangle on the Detector Widget.

1. Hold the left button of the mouse.
2. Move the mouse to draw a rectangle on the ROI.
3. Release the left button of the mouse.

O Tip: The ROI rectangle is only visible when Select focus region is enabled. When enabled, you cannot
change the RGB, spatial reference indices, or spectral references indices.

* ROI settings — The GUI ROI allows you to only show a ROI of the acquired frame, in the Detector Widget. This
is particularly useful for sensors like the OWL, where only a subset of the frame contains image data. All the band
indices will be recalculated to fit the GUI ROI selection.

This menu item opens a dialog, where you can Enable the GUI ROI, set the Start band, and set the Stop band.
The Start band and Stop band parameters contain a list of all the bands and wavelengths available for the sensor.
The options are in format:

Band ...: ...nm

where

» The Band section is the band index.
» The nm section is the corresponding wavelength.

Managing References
You can add, edit or remove spatial and spectral references in the Detector Widget's options dialog.

The options dialog has two tabs; one for the spectral references and one for the spatial references.
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Ref 2
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Figure 23: Reference Tab in Detector Widget's Options Dialog

The each tab shows a list of the declared references. Each reference is shown with a rectangle of the selected color,
followed by the label.

On the right hand side you can find the Add, Edit and Remove buttons.

Adding areference

1. Click the Add button.

2. Enter a Label name (optional).

3. Select a Color to differentiate the new reference from the others.
4. Click OK.

The new reference is added to the list.

In the case of a spectral reference, a new vertical line is added in the middle of the Detector Widget, and the new
reference is plotted in the Spectral Plot Widget.

In the case of a spatial reference, a new horizontal line is added in the middle of the Detector Widget, and the new
reference is plotted in the Spatial Plot Widget.

Editing a reference

Double click the reference in the list, or select the reference, and click the Edit button.
Modify the Label.

Modify the Color.

Click OK.

Pl ol S

The label and color changes are reflected in the list, Detector Widget, Spectral Plot Widget and Spatial Plot Widget.

Removing areference

1. Select the reference from the list.
2. Click the Remove button.

The reference is removed from the list, Detector Widget, Spectral Plot Widget and Spatial Plot Widget.
Waterfall widget

The Waterfall Widget provides a false color representation of the hyperspectral imager data - as it is acquired - in real-
time.

As a new frame is acquired, the Waterfall Widget is updated in the following order:

1. The Waterfall Widget image is shifted by one pixel in the Y direction, freeing the first row for the new line.
2. The three selected RGB bands are extracted from the new frame.
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3. These three bands are interlaced, and scaled to 8-bit for each color palette into one line.
4. The resulting line is added to the first row.

The RGB bands can be configured in:

» The sensor setup settings group, see Defining the Sensor Parameters.
* The Detector Widget, see Detector widget.
* The Spectral Plot Widget, see Spectral Plot Widget.

The Waterfall Widget hightlights saturated data. Saturated pixels are shown in bright red. A pixel is considered
saturated, if more then 2% of its wavelength pixels are equal to the maximum pixel value.

Data is visualized after image correction operations. For example, enabling the image correction (see Defining the
Image Correction Parameters) causes the Waterfall Widget to show normalized data.

Waterfall Widget Parameters
The Waterfall Widget context menu contains the following parameters:

* Zoom in — This parameter allows you to zoom in the image. You can also zoom in by holding the Ctr1 key and
using the mouse scroll button.

* Zoom out — This parameter allows you to zoom out the image. You can also zoom out by holding the Ctr1 key
and using the mouse scroll button.

» Fit to window — This parameter will automatically calculate the zoom level required to fit the entire Waterfall
Widget image in the parent window, while keeping the aspect ratio.

O Tip: While Fit to window is activated, you cannot Zoom in or Zoom out.

» Horizontal flip — This parameter flips the image horizontally. The recorded data remains unaffected.

* Vertical flip — This parameter flips the image vertically. The recorded data remains unaffected.

* Rotate CW — This parameter rotates the image clockwise. The recorded data remains unaffected.

* Rotate CCW — This parameter rotates the image counterclockwise. The recorded data remains unaffected.

* Contrast Brightness — This menu item opens a Contrast & Brightness dialog, where you can fine tune both
parameters. The recorded data remains unaffected.

Spectral Plot Widget
The Spectral Plot Widget shows the pixels values at the locations of spectral references as two-dimensional plots.
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Figure 24: Spectral Reference on the Detector

A spectral reference refers to a column on the detector.

The corresponding wavelength of the row number is shown in the X axis. The raw pixel value is shown on the Y axis,
and the maximum pixel value depends on the sensor used.

You can add spectral references through the Detector Widget's context menu. (See Managing References).
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RGB bands in Spectral Plot Widget
The RGB bands are drawn in the Spectral Plot Widget at the positions specified by their corresponding wavelengths.
The RGB bands can be changed in the Spectral Plot Widget as follows:

1. Place the mouse cursor on top of a band.

2. Select it by holding the left button of the mouse.
3. Move the band by sliding the mouse left or right.
4. Release the left button of the mouse.

Plot Widget Parameters

The plot parameters allow the customization of the X and Y axis. The parameters can be found from the Options
menu item in the plot's context menu.

AXxis parameters

» Show label — This parameter controls the visibility of the label on top of the plot (X axis), or on the right-hand
side of the plot (Y axis). It is enabled, that is, visible, by default.

» Label — This parameter resides on the right-hand side of Show label parameter, and controls the text in the label
on top of the plot (X axis), or on the right-hand side of the plot (Y axis). The default labels are:
* Spatial plot X axis —Pixels
* Spectral plot X axis —Wavelength
» Spatial and Spectral Y axis — DN

» Show grid — This parameter controls the visibility of the vertical grid lines (X axis), or the horizontal grid lines
(Y axis). It is enabled, that is, visible, by default.

*  Grid — This parameter resides on the right-hand side of Show grid parameter, and controls the number of
vertical grid lines (X axis), or horizontal (Y axis) grid lines.

* Autoscale — This parameter automatically calculates the Min and Max range parameters for the X and Y axis.

» Spatial plot X axis — All the spatial pixels are plotted.

» Spectral plot X axis — All the spectral pixels are plotted.

» Spatial and Spectral Y axis — The range is continuously updated. For the Min parameter, the closest exponent
to two, that is below the parameter value itself, is used. For example, if the value is 130, the closest exponent
of two is 2*7=128. For the Max parameter, the closest exponent to two, that is above the parameter value
itself, is used. For example, if the value is 230, the closest exponent of two is 2*7=256. With the values above,
the range would be [128, 256].

Plot parameter

+ Update graph — When this check box is checked, redrawing is enabled. Otherwise, it is paused.

Context menu shortcuts
The plot's context menu provides the following shortcuts:

» Update — A shortcut for Update graph.
* Autoscale:

» X-axis — A shortcut for the X axis Autoscale.
* Y-axis — A shortcut for the Y axis Autoscale.

* Options — Opens the plot's options menu.

Keyboard shortcuts
The keyboard shortcuts are:

+ Update — space key.
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* Set the manual scale — Hold the Ctr1 key, press the left mouse button, select an area on the plot, and release
the left mouse button.

* Reset the manual scale — Hold the Ctr1 key, and click the right mouse button.
Spatial Plot Widget
The Spatial Plot Widget shows the pixels values at the locations of spatial references as two-dimensional plots.
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Figure 25: Spatial Reference on the Detector

A spatial reference refers to a row on the detector.

The column number is shown as the X axis. The raw pixel value is shown on the Y axis, and the maximum pixel
value depends on sensor used.

You can add spatial references through the Detector Widget's context menu. (See Managing References).
Plot Widget Parameters

The plot parameters allow the customization of the X and Y axis. The parameters can be found from the Options
menu item in the plot's context menu.

Axis parameters

* Show label — This parameter controls the visibility of the label on top of the plot (X axis), or on the right-hand
side of the plot (Y axis). It is enabled, that is, visible, by default.

* Label — This parameter resides on the right-hand side of Show label parameter, and controls the text in the label
on top of the plot (X axis), or on the right-hand side of the plot (Y axis). The default labels are:

» Spatial plot X axis —Pixels
» Spectral plot X axis —Wavelength
» Spatial and Spectral Y axis — DN
* Show grid — This parameter controls the visibility of the vertical grid lines (X axis), or the horizontal grid lines
(Y axis). It is enabled, that is, visible, by default.

*  Grid — This parameter resides on the right-hand side of Show grid parameter, and controls the number of
vertical grid lines (X axis), or horizontal (Y axis) grid lines.

* Autoscale — This parameter automatically calculates the Min and Max range parameters for the X and Y axis.

» Spatial plot X axis — All the spatial pixels are plotted.

* Spectral plot X axis — All the spectral pixels are plotted.

» Spatial and Spectral Y axis — The range is continuously updated. For the Min parameter, the closest exponent
to two, that is below the parameter value itself, is used. For example, if the value is 130, the closest exponent
of two is 2*7=128. For the Max parameter, the closest exponent to two, that is above the parameter value
itself, is used. For example, if the value is 230, the closest exponent of two is 2*7=256. With the values above,
the range would be [128, 256].
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Plot parameter

+ Update graph — When this check box is checked, redrawing is enabled. Otherwise, it is paused.

Context menu shortcuts
The plot's context menu provides the following shortcuts:

» Update — A shortcut for Update graph.
* Autoscale:

e X-axis — A shortcut for the X axis Autoscale.
* Y-axis — A shortcut for the Y axis Autoscale.

* Options — Opens the plot's options menu.

Keyboard shortcuts
The keyboard shortcuts are:

+ Update — space key.

* Set the manual scale — Hold the Ctr1 key, press the left mouse button, select an area on the plot, and release
the left mouse button.

* Reset the manual scale — Hold the Ctr1 key, and click the right mouse button.

Capture View

The Capture View content area contains one to multiple Waterfall Widget, depending on the number of sensors present
in the system.

Sensor 1 name Sensor 2 name
Sensor 1 waterfall widget Sensor 2 waterfall widget
Sensor 1 workflow status Sensor 2 workflow status

Figure 26: Capture View with Two Sensors

The Capture View content area shows, side by side, the sensor name, the waterfall status, and the workflow status.

» The height of the Sensor X name is fixed. The width is synchronized with the Waterfall Widget and the workflow
status widget below. Sensor X name is replaced with the actual sensor name.
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» The height of the Sensor X waterfall widget changes dynamically to fill the entire heigh of the content area. It
displays the same image data, saturations, and so on, as the Adjust View for sensor X.

* The height of the Sensor X workflow status changes automatically as new status information is added. The area
contains:

* The Frame rate and disk space status, in one of the following formats:

* Fps: ... | Free disk space: ...h ...m ...s.
* Fps: ... | Free disk space: ...GB.
E Note: You can select to display the free disk space either in time or in size. Select Free disk space >

Show disk space in time, or Free disk space > Show disk space in size.
» The recording status for each new file type recorded. The format is: Type: Recorded: ... |
Dropped: ..., where:
* Type is replaced with Image, White reference, Dark reference, and so on. See Table 5. File
Prefixes for the list of types.
* Recorded is followed by the number of recorded frames on the disk.
* Dropped is followed by the number of dropped frames.

Each sensor name, waterfall and workflow status column width can be enlarged to have more space for one sensor.

1. Place the mouse cursor on top of the splitter between the columns.
2. Hold the left button of the mouse.

3. Move the mouse left or right to change the column size.

4. Release the left button of the mouse.

Left Pane

When the Capture View is selected, the left pane contains the following controls:
* Sensor(s) parameters

Right Pane

When the Capture View is selected, the right pane contains the following controls:

* Recorder group: This group has the Stop and Record buttons used to start, stop or abort the workflows.

*  Workflow settings group: This group contains the workflow selection and the parameter definition for each of
them.

* Metadata group: Usually, this group contains the Dataset name, Operator and Description. The metadata fields
are configurable so the content of this group will change depending on the setup.

» Traffic lights group: shows some vital system information, warning and error. See Monitoring the Traffic Lights.

Initial Setup

This section will guide you through the initial setup and configuration of the software.

Defining the Logging Parameters
This section describes how to define the application's logging parameters.

Thanks to detailed error messages, the application is able to supply logging information for identifing various issues.
The information also includes basic run log information.

To view logging parameters, select Setup View > Logging.
Proceed as follows:

1. Define the Log folder.

You can either enter the log folder path in the line edit Widget, or click the button next to it. A folder dialog will be
opened, and you can select the folder.
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O Tip: Itis a good idea to have a dedicated log folder for each application.

2. Select Enable logging.

Defining the Log folder is not enough. To have the logging information written to the log files, check the Enable
logging check box.

3. Select Show log window.

When this check box is checked, a logging widget is visible below the content area. In this widget, you can see
real-time logging information, and control the visibility of the messages, warnings, and errors. You can also define
the order in which new messages are added: ascending or descending.

Defining the Sensor Parameters
This section describes how to define the sensor parameters.

Connect the sensor to the computer, install the drivers, and power up the sensor, before you start the application.

The application supports recording data for one or multiple local sensors. Each sensor in the application and
workflows is referred to by an index, that is, Sensor 1, Sensor 2, Sensor 3, and so on. For each sensor:

» Specify the physical hardware sensor.

* Load some calibration data.

» Set some parameters for visualization, dataset naming, and so on.

To view the sensor parameters, select Setup View > Sensor X, where X refers to the sensor index.
Proceed as follows:

1. Select the Sensor.

The first available parameter in the sensor settings group is the sensor selection combo box. This combo box
enumerates all the available sensor profiles located in C: \Users\Public\Documents\Specim. These
profiles are preconfigured by Specim, and provided with the delivery. They have a .ssp file extension.

Select your sensor from the list, make sure it is powered up.

2. Connect to the sensor.

To connect to the sensor, click the Connect button. If the connection is successful, the Disconnect button is
activated, and the Connect button is deactivated. If the connection fails, check the Log window for more detailed
information, and review the parameters.

E Note: Depending on the sensor, the connection and initialization can take from a few seconds up to
dozens of seconds.
3. Select the sensor's Calibration pack.

The calibration pack is an archive containing all the calibration data related to your sensor, including wavelength
information, radiometric and geometric calibrations (if available), and so on.

The calibration pack has a *.scp file extension. It is prepared by Specim, and provided with the delivery.

Warning: It is possible to capture data without a valid calibration pack, but all calibration information
will default to the generated estimated values, which are incorrect for your sensor. The spectral
information being missing, the data will be unusable.

a) Open the file dialog selector by clicking the Calibration pack parameter.
b) Select the calibration pack you have received.
¢) We recommend that you place the calibration packs in C: \Users\Public\Documents\Specim
\CalibrationPacks.
4. Click the Capture folder parameter button to select the folder.
The capture folder is the folder were the datasets will be recorded.

] Important: The capture folder cannot be on the same hard drive as the operating system. This may cause
dropped frames, because of insufficient writing speed. Use fast storage disks, such as SSDs on SA4TA3
interface.
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5. Define the Dataset prefix.
The Dataset prefix parameter is part of the dataset name, and can help identify the sensor.

For example, a system could have a SWIR camera and a VNIR camera on the same computer. It is not
recommended, but possible, to set the same capture folder for both sensors. Without a prefix, the dataset names
would be identical, and the workflow would fail since each dataset must have a unique name.

Using the following dataset naming parameters:

* Name generator: counter with value 20
+ Naming format: prefix name counter
» Dataset name: hello

*  SWIR sensor Dataset prefix: SWIR

* VNIR sensor Dataset prefix: VNIR

The full dataset names will be unique, and can be put in the same capture folder:

* SWIR hello 20
* VNIR hello 20

6. Select the RGB bands.

You can select the RGB bands using the Red band, Green band and Blue band parameters. Each choice in the
band parameter displays the Band number as an index starting from 1, and the corresponding wavelength number.

E Note: When available in the application, it is also possible to set the RGB bands from the Detector
Widget, or the Spectral Plot Widget.

Defining the GPS parameters

This section describes how to define the GPS parameters.
Connect and power up the GPS, before you start the application.

The application supports recording data for one or multiple local GPSes, and to synchronize it with the sensors' data.
Each GPS in the application and workflows are referred to by an index, that is, GPS 1, GPS 2, GPS 3, and so on. For
each GPS, specify the physical hardware unit to connect to.

To view GPS parameters, select Setup View > GPS X, where X refers to the GPS index.
Proceed as follows:

1. Select the GPS.

The first available parameter in the GPS settings group is the GPS selection drop-down menu. This drop-down
menu enumerates all the available GPS profiles located in C: \Users\Public\Documents\Specim. These
profiles are preconfigured by Specim and provided with the delivery.

a) Select your GPS from the list, and make sure it is powered up.
2. Connect to the GPS.

a) Click the Connect button.

« If'the connection is successful, the Disconnect button is activated, and the Connect button is deactivated.
» If the connection fails, check the Log window for more detailed information, and review the parameters.

Defining the Remote Control Server Parameters
This section describes how to configure the remote control server parameters.

The application has a built-in remote control server, allowing another application using Lumo Remote SDK to take
control over it.

The communication with this application, the server, is done through a network protocol, and the application using
Lumo Remote SDK is a client.

To view remote control server parameters, select Setup View > Remote Control Server.
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Proceed as follows:

1. Define the Address.
The address can be the URL or the /P address of the computer running this application.
O Tip: Using the 0.0.0.0 /P address ensures that the server is listening on all the /P addresses available on
the computer, even if multiple N/Cs are used.
2. Define the Port.
The port can be a number between 1 and 65535. The port must be available on the computer.
3. Start the remote control server and validate the parameters.

A Start button and a Stop button are available below the Port parameters. Click the Start button to start the
server. If the server is started , the Start button is deactivated, and the Stop button is activated. If the server does
not start, see the Log window for a detailed description, and review the parameters.

Note: The first time the remote control server is started, Windows will prompt you to make an exception
rule for the port you have selected. If the server is started, but you cannot connect to this application from
Lumo Remote SDK, review your firewall settings, and make sure that the port is open on all the required
network types (Domain, Home/Work and Public) .

[

Defining the Remote Sensors Parameters
This section describes how to configure the remote sensors parameters.

The application is able to connect to remote sensors and control the parameters to accommodate setups where it is not
possible to install multiple sensors on the same computer. The sensors can be a HS/ or a GPS/INS.

This application, the master, connects and controls the parameters and workflows of a slave application. The slave
application, Lumo Recorder, is running on a different computer where the sensors are attached.

The communication with this application, the server, and the slave Lumo Recorder is done via a network protocol and
uses Lumo Remote SDK.

The software is pre-configured to include X number of remote computers. Each remote computer can have several
sensors.

The remote sensor parameters can be found from the Setup View in the Remote computer X settings group where X
refers to the remote computer index.

Note: Make sure that the slave computer running Lumo Recorder is powered ON, that the sensors are
powered ON, that Lumo Recorder is running and that at least its remote control server (see Defining the
Remote Control Server Parameters) is started.

L=F

Proceed as follows:

1. Define the Address.
The address can be the URL or the /P address of the remote computer running Lumo Recorder .
2. Define the Port.

The port can be a number between 1 and 65535. It must be the same than the one the slave Lumo Recorder's
remote control server is listening on.

3. Connect to the remote computer and validate the parameters.

Click the Connect button. If the connection is successful, the Disconnect button is activated, and the Connect
button is deactivated. If the connection fails, check the Log window for more detailed information, and review the
parameters.

E Note: If the connection is successful, the slave Lumo Recorder's sensors are listed below the remote
computer Connect and Disconnect buttons.
4. Define the Sensor Parameters.

Each remote HSI sensor is listed below the remote computer Connect and Disconnect buttons, and has the same
parameters as a local sensor, that is:
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» Sensors SSP selection
» Connect button

* Disconnect button

» Calibration pack

» Capture folder

* Dataset prefix

 Redband
e Green band
e Blue band

See Defining the Sensor Parameters.
5. Define the GPS parameters.

Each remote GPS sensor is listed below the remote computer Connect and Disconnect buttons, and has the same
parameters as a local GPS, that is:

e GPS SSP selection
* Connect button
» Disconnect button

See Defining the GPS parameters

Defining the Task Manager Parameters
This section describes how to define the task manager parameters.

Lumo Task Manager must be started and the server must listen for incoming traffic.

Lumo Task Manager can be used to start, stop, restart or kill this application from a remote computer. To allow this,
the application must register its process information to Lumo Task Manager.

The communication with Lumo Task Manager, the server, takes place through a network protocol, and this
application is a client.

Define the network address and the port Lumo Task Manager is listening on.
To view Task Manager parameters, select Setup View > Task Manager.
Proceed as follows:

1. Define the Address.
The Address can be a URL or an /P address. It must be the one Lumo Task Manager is listening on.
2. Define the Port.
The port can be a number between 1 and 65535. It must be the one Lumo Task Manager is listening on.

3. Register the application, and validate the task manager parameters.

Click the Register button. The registration is almost instant. If the Task Manager parameters are correct, the
Register button will become inactive, and the Unregister button will become active.

Additionally, a red or green bullet icon on the right hand side of the Register button will display the registration
status:

* Green stands for registered.
* Red stands for unregistered.

If the registration fails, review the Task Manager's parameters.

Defining the Thermal Calibrator Parameters

This section describes how to define the thermal calibrator parameters.

The thermal calibrator must connected to the computer and powered up, before starting the application.
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The thermal calibrator is a device designed for the thermal sensors.

The thermal calibrator has two plates (blackbodies) with configurable temperatures. One blackbody will be measured
as a cool reference. The other one, warmer, will be measured as a warm reference. A single controller for the two
blackbodies regulates the temperatures.

The thermal calibrator also has a motor allowing the positioning of the blackbodies in front of the fore objective.

Both the controller and the motor must be configured and initialized successfully, to be able to use the thermal
calibrator workflows.

To view thermal calibrator controller parameters, select Thermal calibrator controller > Setup View.
Proceed as follows:

1. Define the IP address.
The blackbody controller's default /P address is 192.168.1.201.

E Note: Do not change the default address, unless networking restrictions force you to.

2. Define the Port.
The blackbody controller's default port is 2101.

E Note: Do not change the default port, unless networking restrictions force you to.

3. Select the Motor COM Port.

The motor COM ports are auto detected when the application starts. Select the thermal calibrators COM port
from the combo box.

4. Connect to the thermal calibrator.
A Connect button and a Disconnect button are available, below the Motor COM Port parameter. Click
Connect to connect to the thermal calibrator, and initialize it. If the connection succeeds, the Disconnect button

is activated, and the Connect button is deactivated. If the connection fails, check the Log window for more
information, and review the thermal calibrator parameters.

5. Monitor the temperature stabilization.

The blackbody controller can report if the temperatures are stabilized or not. The T1 stabilized and T2 stabilized
reports available below T2, report if the blackbodies are stabilized. Also, the T1 measured (°C) and T2 measured
(°C) reports display the measured blackbody temperatures.

Note: When the blackbody controller is powered up, dozens of seconds are required until the

Qi

temperatures become stabilized. If a blackbody temperature exceeds the tolerance of = 0.02°C from the set
temperature, the blackbody will be marked as unstable.
(1] Warning: When the motor moves the blackbodies, their temperatures become unstable. The recording

workflow for the cool and warm reference will allow a maximum of 30 seconds for the temperatures to
stabilize again after a movement, otherwise the recording workflow will fail.

Defining the Dataset Naming Parameters
This section describes how to define the dataset naming parameters.

A dataset full name is created using three parameters:

» The dataset name often set in the metadata.
* The value of the name generator.
» The value of the sensor prefix (see Defining the Sensor Parameters).

To view dataset naming parameters, select Setup View > Dataset.
Proceed as follows:

1. Select a Name generator.

Possible values are:
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* Timestamp — A timestamp is added to the dataset full name when the recroding workflow is started. When
selected, the Timestamp format parameter is available. This is where you have to define the timestamp
format. The following patterns will be replaced by their corresponding values. They can be used in any order.

! -UTC time

* %Y - Full year

*  %m - Month

* %d - Day of month

* %H - Hour, using a 24-hour clock
* %I - Hour, using a 12-hour clock
* %M - Minute

* %S - Second

For example: ! $Y-%m-%d_$H-%M-%S would give 2015-12-31_13-59-01.

O Tip: To display a tooltip of the syntax, hover your mouse over the Timestamp format label for one
second.

» Counter — When selected, a counter value is added to the dataset full name. The counter value is
automatically incremented at the end of the recording workflow. When selected, the Counter value setting is
available. It contains the value that will be used at the next recording workflow.

* None — If you select the None name generator, no name generator will be used.
2. Select a Naming format.

The Naming format drop-down list lets you choose the position of the name generator in the dataset name. The
choices are:

* Timestamp Name generator selected:

* prefix name_ timestamp
e prefix timestamp name
* timestamp name prefix
* timestamp prefix name
* name prefix timestamp
* name timestamp prefix
* timestamp name

* name_ timestamp

* Counter Name generator selected:

* prefix name counter

* prefix counter name

* counter name prefix

* counter prefix name

* name prefix counter

* name counter prefix

* name counter counter name
* None Name generator sclected:

* prefix name
* name prefix
* name

Defining the General Parameters
This section describes how to define the general parameters.

The general parameters control a number of basic aspects in the application, and provide you access to the About
dialog.

All rights reserved - Specim, Spectral Imaging Oy Ltd.



| Lumo Recorder User Manual | 32

To view general parameters, select Setup View > General.
Proceed as follows:

1. Select Minimize the application to system tray.

When enabled, the application icon is added to the system tray. If you click the main window's minimize button,
the main window will be hidden. To show the main window again, double click the application icon in the system
tray, or right click it and select show.

E Note: Each application can have a different set of options in the tray icon context menu.

2. Select Show application in full screen mode (F11).

When enabled, the application's main window will cover the entire screen. You will not be able to see the
Windows start menu button, task bar, system tray or the application's title bar. You can toggle this option with the
F11 key.

3. Select Start automatically when you log to this computer.

When enabled, Start automatically when you log to this computer will start the application when the user logs
in. If the computer does not have login enabled, the application will start automatically when the computer boots
up, since no user name nor password will be asked. Starting the application does not mean that the devices will be
initialized.

4. Define Startup delay (seconds).

This option defines the delay from application startup to automatic initialization, when the software is started
automatically when logging on to the computer. Some of the computers subsystems may need some time to
initialize properly. The necessary delay depends on the systems configuration and can only be determined
experimentally. A delay of at least 10s is recommended with the Windows® operating system.

(1] Warning: If the delay is too short, the application startup will fail.

O Tip: If initialisation fails, restart the application (not the computer!) and verify that everything works. If
everything works as it should, set a longer startup delay and reboot the computer to try again.

5. Select Auto initialize when the application starts.

With Auto initialize when the application starts enabled, all the configured devices will automatically be
connected and initialized, with the previous settings, when starting the software. If a device fails connecting, the
auto-initialization procedure will continue, if possible.

O Tip: Enable this parameter only after you have fully configured your system.

6. Click the About... dialog option.

The About... dialog will show the application name, version, and enumerate all the modules loaded from the
application directory with their version. This information will help the Specim's support (support@specim.fi) team
in case you have issues with your system.

O Tip: The Contact support link will open a new email containing all the binaries information. Please use
it if you have issues with your system.

Selecting the Recording Workflow

This section describes how to select the workflow.

The application has an internal scripting engine controlling all the steps required to produce a dataset. The recording
Workflows consist of sequential steps, each step focusing on a specific task.

A workflow is defined for a specific sensor type and accessory, and can also control the content of the final dataset.
To view workflow selection parameters, select Capture View > Workflow settings.
Proceed as follows:

1. Select a Workflow.

The workflows are:
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* Image
» Dark image
* Image and dark image
» Image with GPS Data and Dark Image
» Image, Dark Image and Thermal Images
» Image with GPS Data, Dark Image and Thermal Images
* Image with Embedded Dark Image
» Image with GPS Data and Embedded Dark Image
* Image with Embedded Dark Image and Thermal Images
* Image with GPS Data, Embedded Dark Image and Thermal Images
* Thermal Images
* Thermal Images with Embedded Dark
=] Note: The availability of the workflows depends on the connected devices. For example, workflows
involving recording GPS data are only available when a GPS unit is connected, and so on.
2. Define the workflow parameters.
The workflow parameters are specific for each workflow. See each workflow documentation page for more
details:
*  Image
*  Dark Image
» Image and Dark Image
» Image with GPS Data and Dark Image
» Image, Dark Image and Thermal Images
» Image with GPS Data, Dark Image and Thermal Images
» Image with Embedded Dark Image
» Image with GPS Data and Embedded Dark Image
* Image with Embedded Dark Image and Thermal Images
» Image with GPS Data, Embedded Dark Image and Thermal Images
»  Thermal Images
*  Thermal Images with Embedded Dark

Defining the File Transfer Parameters
This section describes how to define the file transfer parameters.

If the recorded datasets must be transferred to another computer, the recording workflows are able to automatically
queue the datasets into Lumo FileTransfer Server, which will transfer the files.

To view file transfer parameters, select Setup View > File Transfer.
Proceed as follows:

1. Select Enabled.

Enabling the file transfer parameter is a global parameter for all the recording workflows. When enabled, every
successfully recorded dataset will be queued in Lumo FileTransfer Server.

2. Define the Lumo FileTransfer Server Executable path.

The files will be queued to Lumo FileTransfer Server using the command line interface. To do that, the application
must know the full path of the Lumo FileTransfer Server executable.

a) Click the Executable path button.
b) Select the Lumo FileTransfer Server executable.

For example, C: /Program Files/Specim/Lumo - FileTransferServer/l1 2 2014 1160/
FileTransferServer-x64.exe.
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Importing and Exporting the Settings
This section describes how to import and export the settings.

The application stores settings into an XML file. The settings can be imported and exported for backup and restore
operation or sharing settings across different computers.

The import / export parameters can be found from the Setup View in the Import/export settings settings group.
Proceed as follows:

1. Click Export settings to.
When you click the Export settings to button, a dialog asks you to enter the file name for the exported settings
file, and the folder location. After entering this information, click the Save button.
If the settings have been successfully written, a confirmation dialog will prompt Settings exported
successfully.

2. Click Importing settings from.
When you click the Import settings from button, a dialog lets you select a settings file previously exported.

3. After selecting the settings file, click on Restart button to continue with the import, or Cancel import button to
cancel the import.

If you continue with the import all the current settings will be lost. After the application restart, the settings are
now restored.

(1] Warning: Importing settings will overwrite the current settings and they will be lost. Make sure to
backup your settings before an import.

Adjusting the Sensor

This chapter contains instructions for adjusting the sensor.

Adjusting the Sensor Parameters
This section describes how to adjust the sensor parameters.

Controlling the Shutter
This section describes how to control the shutter.

The Shutter control will open and close the shutter. When the shutter shows Opened, the light goes through the
instrument.

Proceed as follows:

1. Select Capture View or Adjust View.
2. Locate the sensor widget on the left-hand side panel.
The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.
3. Locate the Shutter parameter.
4. Open the shutter.

Click the check box showing Closed. The check box now shows Opened and the light goes through the
instrument.

5. Close the shutter.

Click the check box showing Opened. The check box now shows Closed and the light does not go through the
instrument.

Defining the Frame Rate
This section describes how to define the frame rate.
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The Frame rate parameter controls the number of frames per second the sensor will output. The maximum frame rate
is sensor-specific. The higher the frame rate, the more data will be recorded by the application.

The frame rate is in close relationship with the exposure time and readout time. These three parameters define the
frame time. The sensor's minimum frame time defines the maximum frame rate.

The application is designed to provide a constant frame rate. Setting the frame rate may require changing the
exposure time, if it exceeds the frame time, see Figure 27: Frame Times.
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Tip: When dealing with slow hard drives, it may not be possible to record all the data, and dropped frames
will be reported. Lowering the frame rate can help to fix this problem, and return to zero dropped frames.

Figure 27: Frame Times

Proceed as follows:

1. Select Capture View or Adjust View.
2. Locate the sensor widget on the left-hand side panel.
The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.
3. Locate the Frame rate parameter.
4. Define the frame rate.
You can change the value by:
1. Entering the value using the numeric keys.
2. Using the mouse scroll wheel.
3. Using the keyboard up and down arrows.
5. Click Apply.

Depending on the sensor, applying the new frame rate may be a very quick action, or take dozens of seconds. If
the exposure time value was decreased, the parameter will have a red outline to warn you of the change. Click
Apply again to get rid of the outline.

Defining the Exposure Time
This section describes how to define the exposure time.

The Exposure time parameter controls the length of time the detector will integrate the light. The maximum exposure
time is sensor-specific. The higher the exposure time, the brighter the image, and the better the signal to noise ratio.

The exposure time is in close relationship with the frame rate. The frame rate limits the maximum exposure time
value. See Defining the Frame Rate.

Proceed as follows:

1. Select Capture View or Adjust View.
2. Locate the sensor widget on the left-hand side panel.
The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.

3. Locate the Exposure time parameter.
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4. Define the exposure time.
You can change the value by:
1. Entering the value using the numeric keys.

2. Using the mouse scroll wheel.
3. Using the keyboards up and down arrows.

5. Click Apply.
Depending on the sensor, applying the new exposure time may be a very quick action, or take dozens of seconds.

Defining the Binning
This section describes how to define the binning.

Spectral binning controls how many rows of the detector will be binned. Spatial binning controls how many
columns of the detector will be binned. The binning can be summing or averaging, depending on the sensor.

Applying binning reduces the original data size by the spectral and spatial binning factor. If the binning is performed
in the camera, less data will have to be transferred and, for certain sensors, it will be possible to achieve a higher
frame rate.
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Figure 28: Spectral Binning by 2
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Figure 29: Spatial Binning by 2

Proceed as follows:

1. Select Capture View or Adjust View.

The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.
3. Locate the Spectral Binning parameter, and select a binning value.
4. Locate the Spatial Binning parameter, and select a binning value.
5. Click Apply.
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Depending on the sensor, applying the new binning parameters may be a very quick action, or take dozens of
seconds. Decreasing binning values can decrease the frame rate, if the sensor cannot handle the throughput with
larger frame dimensions. If the frame rate value was changed, the parameter will have a red outline to warn you of
the change. Click Apply again to get rid of the outline.

Enabling the Bad Pixel Replacement
This section describes how to enable the bad pixel replacement.

When enabled, the bad pixels of the sensor will be replaced with values estimated using the neighboring pixels. The
implementation, and which neighboring pixels are used, is sensor specific.

Proceed as follows:

1. Select Capture View or Adjust View.
2. Locate the sensor widget on the left-hand side panel.
The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.
3. Locate the BPR parameter.
4. Enable BPR by checking the check box.
5. Click Apply.
Depending on the sensor, applying the new BPR parameter may be a very quick action, or take dozens of seconds.

Defining the Non Uniformity Correction Parameters
This section describes how to define the non uniformity correction parameters.

The NUC parameter defines the NUC table that will be applied. A NUC table is dedicated to a certain exposure time
range.

You can choose to set the parameters manually or automatically. If you choose to set the NUC parameter values
manually, you must know the table to set.

Proceed as follows:

1. Select Capture View or Adjust View.
2. Locate the sensor widget on the left-hand side panel.
The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.
3. Locate the Auto NUC parameter.
4. To let the software set the NUC parameter automatically, check the Auto NUC checkbox, and click Apply.
With Auto NUC enabled, the NUC parameter is disabled, but still displays the NUC value set by the application.
5. To manually set the NUC parameter, uncheck the Auto NUC checkbox.
The NUC parameter is enabled.
6. Select the NUC value from the combo box.
7. Click Apply.

Depending on the sensor, applying the new NUC parameter may be a very quick action, or take dozens of seconds.

Defining the Camera Trigger Mode
This section describes how to define the camera trigger mode.

The Trigger mode specifies if the sensor will use the Internal or External triggering method:

* Internal triggering method is the default setting for spectral cameras.
» External triggering is used when the sensor data must be synchronized with another device, such as GPS, or a
second sensor. External triggering must always be used on airborne systems.

Proceed as follows:

1. Select Capture View or Adjust View.

2. Locate the sensor widget on the left-hand side panel.
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The sensor widget has the name of the sensor selected in sensor settings. See Defining the Sensor Parameters.
Locate the Trigger mode parameter.

Select the Trigger mode from the combo box.

Click Apply.

Depending on the sensor, applying the new Trigger mode parameter may be a very quick action, or take dozens of
seconds.

Defining the Image Correction Parameters
This section describes how to define the image correction parameters.

Image correction is used to improve the real-time visualisation of data shown in the Detector Widget and in the
Waterfall Widget. The recorded data is unaffeected by image correction options.

The Image correction Widget is located in the right side pane of the Adjust View.

Note: The parameters are only visible when the sensor is connected. The sensor parameters need to be
defined prior to performing these steps to get good image correction results.

Proceed as follows:

1.

Select Enabled.
When Enabled is True, image correction is applied.
Select the Dark Subtraction parameter.

Pixels may not be entirely dark, even when no light reaches the sensor. This is called the dark current level. To
correct the image, dark current is subtracted from the data. The dark current reference can be acquired from the
sensor or defined by the user, with one of the options below:

» The Shutter option has a dedicated workflow. The sensor’s shutter closes and 100 frames are acquired.

The frames are averaged to a single dark reference frame, and the shutter re-opens. Each pixel has its own
measured dark current value.

» Using the Constant option, a single dark current value is used, which is defined in the Dark constant field.

* The Thermal Calibrator setting has a dedicated workflow. Thermal calibrators are used with thermal sensors.
The thermal calibrator places the cool reference under the fore objective, and acquires 100 frames. The frames
are averaged to a single dark reference frame, and the thermal calibrator retraces to allow imaging again. Each
pixel in the frame has its own measured dark current value.

» The Manual option has a dedicated workflow. First, you obstruct the fore objective. Next, 100 frames are
acquired and averaged to one single dark reference frame. Each pixel has its own measured dark current value.

* The Scanner option has a dedicated workflow. The scanner moves to the dark reference start position, and 100
frames are acquired. The frames are averaged to a single dark reference frame, and the scanner retraces. Each
pixel has its own measured dark current value.

Select Run dark.
This will acquire and apply the captured or defined dark current level.
Select the White reference parameter.

The white reference specifies the maximum pixel value for all pixels. Together with the dark reference, the white
reference is used for . The white reference can be acquired from the sensor or defined by the user, with one of the
options below.

* Using the Constant option, the constant defined in the White constant fiecld will be used as the white
reference.

* The Manual option has a dedicated workflow. First, you place a white reference object under the fore
objective. Next, 100 frames are acquired and averaged to get a single white reference frame. Each pixel in the
frame has its own measured maximum value.

* The Thermal Calibrator option has a dedicated workflow. Thermal calibrators are used with thermal sensors.
The thermal calibrator places the warm reference under the fore objective, and acquires 100 frames. The
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frames are averaged to a single white reference frame, and the thermal calibrator retraces to allow imaging
again. Each pixel in the frame has its own measured maximum value.

* The Scanner option has a dedicated workflow. The scanner moves to the white reference start position, and
100 frames are acquired. The frames are averaged to a single white reference frame, and the scanner retraces.
Each pixel in the frame has its own measured maximum value.

* The Radiometric option has a dedicated workflow. The radiometric coefficients are extracted from the
calibration pack. Each pixel in the frame has its own coefficient value.

5. Select Run white.

This will acquire and apply the captured or defined white reference level.

Performing the Focusing
This section describes how to perform the focusing.

The best focus is the least bad focus across all the different wavelengths, which makes focusing difficult by just
looking at the detector Widget. This application provides a software tool to help with the focusing task.

The focusing tool is located in the right side pane of the Adjust View. The focusing rectangle is drawn in the Detector
Widget, also located in the Adjust View.

Proceed as follows:

1. Place a focusing grid under the fore objective.
2. Select the focus region mode.

Right-click the Detector Widget and from the menu, and choose Select Focus region.
3. Paint the focus region rectangle.

On top of the Detector Widget, press and hold the left mouse button, while dragging the mouse to define the focus
region. Release the mouse button when satisfied with the region.

4. Click the Run button.
5. Find the best focus.

Rotate the fore object to achieve an image or spatial reference with sharp contrast. The best focus value in
percentage is the one closest to 100%.

6. Find the worst focus.
Rotate in one direction to find the worst focus. The focus percentage should decrease.
7. Find the best focus again.

Rotate to the opposite direction than you just did to get better focus percentages. Rotate until the focus percentage
starts to decrease again.

8. Set the best focus.

At this point, the software knows the best focus value. Match it by slowly rotating the lens to the best focus
position.

Defining the Aspect Ratio

This section describes how to define the aspect ratio.

Push-broom type imagers record one line of image at a time, when considering a standard 2D image. The X
dimension is recorded for every frame, and the Y dimension is created by moving the target or the sensor, depending
on the system type.

To obtain square pixels with regard to X and Y dimensions, define the speed of the target, or the frame rate.

You can also possibly configure the aspect ratio by imaging a square or a circle, and controlling the shape in the final
image. Figure 30: Aspect Ratio illustrates the effect of a too fast, a too slow, and the correct speed, or frame rate, on
the final image.
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Figure 30: Aspect Ratio

With airborne systems, you cannot check the aspect ratio in this way. It must be calculated using the optics, sensor
properties, and the altitude. To obtain square pixels, change the frame rate or the plane speed.

Manually
This section describes how to define the aspect ratio manually.

Square pixels for the scanned image can be achieved manually by either changing the scanning speed or the frame
rate.

The steps below assume you are able to image an object.
Proceed as follows:
1. Image an object of a known size, with a simple geometry, such as a circle or a square.

» The larger the object the better, as long as the object is within the field of view of the sensor.
* The object should be something that can be easily seen by the sensor in use.

2. Open the recorded image in a viewer.

3. Measure the width (X) and the height (Y) of the object in pixels in the image.

4. Calculatemultiplier = X / Y.
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» If the multiplier is smaller than 1, either the scanning speed is too fast or the frame rate is too slow.
+ If the multiplier is greater than 1, the scanning speed is too slow or the frame rate is too fast.
* The closer the multiplier is to 1, the closer you are to having perfect square pixels.

+ If you want to change the frame rate of the sensor, multiply the current frame rate with the calculated
multiplier, and set the result as the new frame rate.

» If you want to change the scanning speed, divide the current scanning speed with the calculated multiplier, and
set the result as the new scanning speed.

5. Repeat the steps above from step 1, until the multiplier is close enough to 1.

Using the Field of View of the Sensor
This section describes how to define the aspect ratio using the field of view of the sensor.

Square pixels for the scanned image can be achieved by defining the field of view of the sensor.

In rotary and mirror scanner setups, the field of view is represented in degrees and it refers to the horizontal field of
view angle that the sensor optics see. This value differs between different types of lenses, and it should be provided
with the specifications on the lens.

In linear scanner setups, the field of view is usually represented in millimeters and it refers to the horizontal field
of view at the target position. The field of view value can be measured from the target by placing a long enough
measuring stick horizontally under the target area and scanning it.

This method requires a valid calibration pack to be loaded for the sensor.
Proceed as follows:

1. Select the 'Field of view' method from the application.

2. Change the 'Field of view' value from the UI.
Whenever the field of view or the frame rate of the sensor changes, the scanning speed is automatically adjusted
using the formula: Scanning speed = (FOV / horizontal pixels) * Frame rate.

3. Confirm by scanning a round object.

Using the Distance to the Target
This section describes how to define the aspect ratio using a known distance to the target.

Square pixels for the scanned image can be achieved by defining the distance to the target in millimeters. This method
is only valid for linear scanner setups.

This method requires a valid calibration pack to be loaded for the sensor.
Proceed as follows:

1. Select the 'Working distance' method from the application.

2. Measure the working distance and change it from the UL
Whenever the distance to the target or the frame rate of the sensor changes, the scanning speed is automatically
adjusted using the formula: Scanning speed = (Detector pixel size * Spatial binning

* Spectrograph magnification * (Distance + Entrance pupil position) * Frame
rate) / Focal length.

3. Confirm by scanning a round object.

Defining the QA/QC Parameters
This section describes how to define the QA/QC parameters.

Note: QA/QC is available in Lumo Recorder only when using SisuRock. It is not available in standalone
Recorder installation.

(5

The QA/QC routine is an automated method to check the recorded data quality. The Q4/QC routine is performed in
the recording workflows when the dataset has been fully recorded. Three options are available:
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» Disabled — The QA4/QC will not be performed.
* Internal — See Internal QA/QC Parameters.
» External — See External QA/QC Parameters.

Internal QA/QC Parameters
This section describes how to define the internal QA4/QC parameters.

The Internal OA4/QOC option provides an automated QA/QC procedure for checking the dataset integrity, and the white
and dark references quality.

The dataset integrity checks for the following criteria:

» All the files listed on the dataset manifest exist on the disk.
* All the RAW files have a matching HDR file.

» All the HDR files have the required keywords, and the information is valid. The following keywords are checked
for validity:

Table 1: Valid ENVI HDR criteria

Keyword Criteria

samples Must exist.

bands Must exist.

lines Must exist.

errors Must be none.

interleave Must be bil.

data type Must be 12.

default bands Must be within range of the bands keyword information.

himg Must match the samples keyword information.

vimg Must match the bands keyword information..

hroi Must match the samples keyword information.

vroi Must match the bands keyword information.

fps Must exist.

tint Must exist.

binning Must exist.

sensorid Must exist.

Wavelength The number of elements must match the bands keyword information.
fwhm The number of elements must match the bands keyword information.

» All the RAW files sizes match the information from their associated HDR files.
The internal QA/QC uses correlation and EMD, to calculate the validity of each reference.

First, the white and dark references are averaged into one single frame per reference. These averaged frames are used
for the correlation and EMD checks.

The correlation calculates the similarity between two probability distribution functions; histograms in this case. The
similarity is measured by dividing the RO/ horizontally from the middle, and taking individual correlation values of
each side. This will allow us to detect distribution anomalies, such as broken lamps, and so on.
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The EMD calculates the minimum cost of turning one probability distribution function into another. It is calculated
over the whole averaged frame. In practice, it checks if the recorded data is close enough to the reference.

With the Internal QA4/QC method selected, the parameters below are available, and must be configured:

White reference
Dark reference
Timeout (ms)
Correlation threshold
EMD threshold

Proceed as follows:

1.

Select the White reference.

The White reference parameter allows you to choose an already acquired white reference file, which is known
to be a good reference. This reference will be compared with the newly recorded white references within the
correlation and EMD checks.

a) Click the White reference parameter button to open the file dialog selector.
b) Select the white reference file.
Select the Dark reference.

The Dark reference parameter allows you to choose an already acquired dark reference file, which is known to be
a good reference. This reference will be compared with the newly recorded dark references within the correlation
and EMD checks.

a) Click the Dark reference parameter button to open the file dialog selector.
b) Select the dark reference file.

Define the Timeout (ms).

The Timeout (ms) parameter allows you to abort the recording workflow in case the computation, abnormally,
takes too much time. The timeout is specified in milliseconds, and -1 refers to inifinite (that is, no timeout).

a) Define the Timeout (ms) value in the spin box of the parameter.
Define the Correlation threshold.

The correlation algorithm generates a value between -1 and 1, where 1 is a perfect match. Usually, a
Correlation threshold of 0.8 is a good starting point value.

a) Define the Correlation threshold value in the spin box of the parameter.
Define the EMD threshold.

The EMD algorithm generates a value between 0 and infinity, where 0 is a perfect match. Usually, a EMD
threshold of 5 is a good starting point value.

a) Define the EMD threshold value in the spin box of the parameter.

The internal Q4/QC routine generates one of the following errors:

Table 2: QA/QC error codes

Error name and code Description

siNoError (0) Successful QA4/0OC check.

siQAQCDarkerThanReference (-1700) The newly recorded reference is too dark.

s1QAQCBrighterThanReference (-1701) The newly recorded reference is too bright.

siQAQCUnevenDistribution (-1702) The newly recorded reference has uneven distribution.
Tip: Check for shutter malfunction, broken
illumination lamps or dirt on the white
reference.
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Error name and code Description

siQAQCIncompatible (-1703) The newly recorded reference is incompatible with the
file set in White reference or Dark reference.

] Important: The files must have the same
samples, bands and binning values.

External QA/QC Parameters
This section describes how to define the external Q4/QC parameters.

The External QA4/QC method provides an interface for calling an external process, which is responsible for the QA4/
OC. The result can be reported back to this application as passed or failed, using a shared memory file.

This method provides flexibility for customers who want to control the QA4/QC, while using the standard recording
workflows.

With the External 04/0C method selected, the parameters below are available:

* Execute

» Startin

» Parameters
e Wait

» Timeout (ms)
* Get return value

O Tip: You can use the Q4/QC calling interface to execute a process not related to Q4/QC. This can be helpful
when integrating the software with another system.

Proceed as follows:

1. Define the Execute parameter.
The External QA4/0OC method uses a uses a command line interface to call the external application. The external
application's full path is required.
The Execute setting allows you to select the executable path of theQA/OC routine using an open file type dialog.
2. Define the Start in parameter.

This parameter allows you to select the start in directory for the executable path. This setting is not mandatory in
most cases, and can be left blank.

3. Define the Parameters parameter.

This parameter is used to specify the command line argument format to be passed to the Q4/QC executable. Any
parameters can be defined as plain text, but the patterns below will be replaced:

jo]

: is replaced by the manifest full path.

s

: is replaced by the manifest file name.
. : is replaced by the manifest file extension.
: is replaced by the manifest directory path.

: is replaced by the manifest directory name (equals to dataset name).

[oF

o o° d° o o° o°
D

n O

: is replaced by the content of the Start in variable.

$mmf: is replaced by the path of the shared memory mapped file (MMF) used to retrieve the result of the
external QA4/QC.

.
©

For example, if a dataset was recorded in D: \data\test dataset, the value of the parameters above would
be:

* %n:D:\data\test dataset\manifest.xml
* %f:manifest

* %e:rxml

* %d:D:\data\test dataset
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* 5%D:test dataset

* %s:D:\data\test dataset\manifest.xml

* %mmf: SPECIM Workflow QAQC test dataset push mmf
4. Enable the Wait parameter.

This parameter specifies if the acquisition workflow needs to wait for the external process to exit. If disabled, the
external application process will be started detached, and this application will not monitor the execution.

5. Define the Timeout (ms) parameter.

This parameter defines how long the application should wait for the QA/OC process to complete. The time is
specified in milliseconds. A timeout of -1 corresponds to no timeout.

6. Enable the Get return value parameter.

This parameter specifies if the acquisition software should read the QA/QC routine result from the shared memory
mapped file, which is used to report if the QA/QC passes or fails. The external routine must write either 1 or
true in ASCII, to report a success. Any other content is considered as failed.

This application is responsible for creating and deleting the shared memory mapped file. The external application
is responsible for opening the shared file from the path given by $mmf, writing 1 or true, and closing the file.

Operating Lumo Recorder

This section describes how to operate Lumo Recorder.

Monitoring the Traffic Lights

This section describes how to monitor the traffic lights.

The traffic lights display information about the current system status. The traffic lights include hardware status
information, received data such as GPS coordinates, when a GPS sensor is connected, undefined application
parameters, and so on.

The traffic lights display three levels:

* OK — This level indicates that everything is all right. The backgroud color is green.

»  Warning — This level indicates that the warning threshold has been exceeded, but the condition is not an error yet.
The background color is orange.

» Error — This level indicates a clear error or a condition within an unacceptable range. The background color is
red.

The fields visible in the traffic lights depend on the hardware used, and the system configuration. The fields shown
can include, for example, the sensor's temperatures, the latest GPS coordinates, message about parameters not set, and
SO on.

The fields can be configured to be only visible on certain warning level.
Proceed as follows:

Ensure no red boxes are shown in the traffic lights.

Recording Data Manually
This section describes how to record data manually.

The controls for starting and stopping recording are located at the top of the Adjust View and Capture View's right-
hand side pane. The Record button will start acquisition, and the Stop button will either stop or abort the acquisition,
depending on which Capture mode mode is selected:

* In the free mode, the acquisition will continue until the stop button is pressed.
* In the scripted mode, the acquisition will be stopped automatically when certain conditions are met, for example,
the desired number of frames has been acquired. Clicking the stop button will abort the recording workflow.

Proceed as follows:
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Define the dataset naming parameters.

See Defining the Dataset Naming Parameters.

Select the Workflow.

Also set all workflow related options, as described in Selecting the Recording Workflow.

Define the Metadata options.

Press the Record button.

Wait for data to be recorded.

End the recording.

If the capture mode is free, press the Stop button. In the scripted mode, acquisition is ended automatically.
Note: A message box will be shown for a few seconds after data acquisition ends, indicating if the

acquisition was successful. The acquisition can fail if there were, for example, too many dropped frames
during the acquisition, or if there was insufficient disk space.

5

Workflows

This section describes the available workflows.

Image

The Image recording workflow will create a dataset which will contain the image data, metadata information,
manifest and thumbnail.

The workflow steps are:

1.

XA AW

Open the dataset.

» Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
Record the image files.

* Open the shutter.

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
* Create the hdr file.

Create the metadata.

Create the image thumbnail.

Extract the radiometric calibration frame, if available, and place a copy in the dataset.

Create the manifest and close the dataset.

Queue the dataset in Lumo FileTransfer Server.

Update the metadata if required.

Update the name generator if required.

Dark Image

The Dark image recording workflow will create a dataset which will contain the dark image data, metadata
information, manifest and thumbnail.

The workflow steps are:

1.

Open the dataset.

» Save the current time.
* Create the dataset name.
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» Create the dataset folder structure.
2. Record the image files.

* Close the shutter.

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
* Open the shutter.

* Create the hdr file.

Create the metadata.

Create the image thumbnail.

Extract the radiometric calibration frame, if available, and place a copy in the dataset.
Create the manifest and close the dataset.

Queue the dataset in Lumo FileTransfer Server.

Update the metadata if required.

Update the name generator if required.

L % =R

Image and Dark Image

The Image and dark image recording workflow will create a dataset which will contain the image data, dark image
data, metadata information, manifest and thumbnail.

The workflow steps are:
1. Open the dataset.

» Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
2. Record the image files.

* Open the shutter.
* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
» Create the image hdr file.

3. Record the dark image files.

* Close the shutter.

* Record the dark image raw file until all scripted frame got recorded.
* Open the shutter.

* Create the dark image hdr file.

Create the metadata.

Create the image thumbnail.

Extract the radiometric calibration frame, if available, and place a copy in the dataset.
Create the manifest and close the dataset.

Queue the dataset in Lumo FileTransfer Server.

. Update the metadata if required.

10 Update the name generator if required.

L XA

Image with GPS Data and Dark Image

The Image with GPS Data and Dark Image recording workflow will create a dataset which will contain the image
data, dark image data, GPS, metadata information, manifest and thumbnail.

E Note: This workflow is dedicated for airborne systems.

The workflow steps are:
1. Open the dataset.

e Save the current time.
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* Create the dataset name.

» Create the dataset folder structure.

Start recording the navigation data.

Wait for the start delay.

Mask the triggers.

Wait for the first PPS to star the image data recording.
Record the image files.

SANRA S o

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
» Create the image hdr file.

7. Wait for the stop delay.

Stop recording the navigation data.

9. Record the dark image files.

*®

* Close the shutter.
* Record the dark image raw file until all scripted frame got recorded.
* Open the shutter.
* Create the dark image hdr file.
10. Create the metadata.
11. Create the image thumbnail.
12. Extract the radiometric calibration frame, if available, and place a copy in the dataset.
13. Create the manifest and close the dataset.
14. Queue the dataset in Lumo FileTransfer Server.
15. Update the metadata if required.
16. Update the name generator if required.

Image, Dark Image and Thermal Images

The Image, Dark Image and Thermal Images recording workflow will create a dataset which will contain the
image data, dark image data, thermal images, metadata information, manifest and thumbnail.

E Note: This workflow is dedicated for thermal sensors.

The workflow steps are:
1. Open the dataset.

» Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
2. Record the image files.

* Open the shutter.
* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
* Create the image hdr file.

3. Record the dark image files.

* Close the shutter.
* Record the dark image raw file until all scripted frame got recorded.
* Open the shutter.
* Create the dark image hdr file.
4. Record the cool (T1) thermal image.

* Move the T1 blackbody under the fore objective.
»  Wait for T1 temperature to stabilize.
* Record the T1 image raw file until all scripted frame got recorded.
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* Create the T1 image hdr file.
5. Record the warm (T2) thermal image.

* Move the T2 blackbody under the fore objective.

»  Wait for T2 temperature to stabilize.

» Record the T2 image raw file until all scripted frame got recorded.
» Create the T2 image hdr file.

Home the blackbodies to allow imaging the scene again.

Create the metadata.

Create the image thumbnail.

Extract the radiometric calibration frame, if available, and place a copy in the dataset.
10 Create the manifest and close the dataset.

11. Queue the dataset in Lumo FileTransfer Server.

12. Update the metadata if required.

© ® e

13. Update the name generator if required.

Image with GPS Data, Dark Image and Thermal Images

The Image with GPS Data, Dark Image and Thermal Images recording workflow will create a dataset which will
contain the image data, dark image data, thermal images, GPS, metadata information, manifest and thumbnail.

= Note: This workflow is dedicated for thermal sensors in airborne systems.

The workflow steps are:
1. Open the dataset.

» Save the current time.

» Create the dataset name.

* Create the dataset folder structure.

Start recording the navigation data.

Wait for the start delay.

Mask the triggers.

Wait for the first PPS to star the image data recording.

AN N

Record the image files.

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
» Create the image hdr file.

7. Wait for the stop delay.

Stop recording the navigation data.

®

9. Record the dark image files.

* Close the shutter.
* Record the dark image raw file until all scripted frame got recorded.
* Open the shutter.
* Create the dark image hdr file.
10. Record the cool (T1) thermal image.

*  Move the T1 blackbody under the fore objective.
»  Wait for T1 temperature to stabilize.
* Record the T1 image raw file until all scripted frame got recorded.
* Create the T1 image hdr file.
11. Record the warm (T2) thermal image.

* Move the T2 blackbody under the fore objective.
*  Wait for T2 temperature to stabilize.
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* Record the T2 image raw file until all scripted frame got recorded.
* Create the T2 image hdr file.
12. Home the blackbodies to allow imaging the scene again.
13. Create the metadata.
14. Create the image thumbnail.
15. Extract the radiometric calibration frame, if available, and place a copy in the dataset.
16. Create the manifest and close the dataset.
17. Queue the dataset in Lumo FileTransfer Server.
18. Update the metadata if required.
19. Update the name generator if required.

Image with Embedded Dark Image

The Image with Embedded Dark Image recording workflow will create a dataset which will contain the image data
files with the dark data added at the end of the image raw file, metadata information, manifest and thumbnail.

The workflow steps are:
1. Open the dataset.

» Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
2. Record the image files.

* Open the shutter.
* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
* Create the image hdr file.

3. Record the dark data.

* Re-open the image file.

* Close the shutter.

* Record the dark data at the end of the image raw file until all scripted frame got recorded.
* Open the shutter.

» Update the image hdr file.

Create the metadata.

Create the image thumbnail.

Extract the radiometric calibration frame, if available, and place a copy in the dataset.

Create the manifest and close the dataset.

Queue the dataset in Lumo FileTransfer Server.

L XA NR

. Update the metadata if required.
10. Update the name generator if required.

Image with GPS Data and Embedded Dark Image

The Image with GPS Data and Embedded Dark Image recording workflow will create a dataset which will contain
the image data files with the dark data added at the end of the image raw file, GPS, metadata information, manifest
and thumbnail.

E Note: This workflow is dedicated for airborne systems.

The workflow steps are:
1. Open the dataset.

« Save the current time.
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* Create the dataset name.

» Create the dataset folder structure.

Start recording the navigation data.

Wait for the start delay.

Mask the triggers.

Wait for the first PPS to star the image data recording.
Record the image files.

SANRA S o

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
» Create the image hdr file.

7. Wait for the stop delay.

Stop recording the navigation data.

9. Record the dark data.

*®

* Re-open the image file.
* Close the shutter.
* Record the dark data at the end of the image raw file until all scripted frame got recorded.
* Open the shutter.
* Update the image hdr file.
10. Create the metadata.
11. Create the image thumbnail.
12. Extract the radiometric calibration frame, if available, and place a copy in the dataset.
13. Create the manifest and close the dataset.
14. Queue the dataset in Lumo FileTransfer Server.
15. Update the metadata if required.
16. Update the name generator if required.

Image with Embedded Dark Image and Thermal Images

The Image with Embedded Dark Image and Thermal Images recording workflow will create a dataset which
will contain the image data files with the dark data added at the end of the image raw file, thermal images, metadata
information, manifest and thumbnail.

B Note: This workflow is dedicated for thermal sensors.

The workflow steps are:
1. Open the dataset.

* Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
2. Record the image files.

* Open the shutter.
* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
* Create the image hdr file.

3. Record the dark data.

* Re-open the image file.
* Close the shutter.
* Record the dark data at the end of the image raw file until all scripted frame got recorded.
* Open the shutter.
» Update the image hdr file.
4. Record the cool (T1) thermal image.
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*  Move the T1 blackbody under the fore objective.
»  Wait for T1 temperature to stabilize.
* Record the T1 image raw file until all scripted frame got recorded.
* Create the T1 image hdr file.
5. Record the warm (T2) thermal image.

* Move the T2 blackbody under the fore objective.

»  Wait for T2 temperature to stabilize.

* Record the T2 image raw file until all scripted frame got recorded.

* Create the T2 image hdr file.

Home the blackbodies to allow imaging the scene again.

Create the metadata.

Create the image thumbnail.

Extract the radiometric calibration frame, if available, and place a copy in the dataset.

L ¥

10. Create the manifest and close the dataset.

11. Queue the dataset in Lumo FileTransfer Server.
12. Update the metadata if required.

13. Update the name generator if required.

Image with GPS Data, Embedded Dark Image and Thermal Images

The Image with GPS Data, Dark Image and Thermal Images recording workflow will create a dataset which will
contain the image data files with the dark data added at the end of the image raw file, thermal images, GPS, metadata
information, manifest and thumbnail.

= Note: This workflow is dedicated for thermal sensors in airborne systems.

The workflow steps are:
1. Open the dataset.

» Save the current time.

* Create the dataset name.

» Create the dataset folder structure.

Start recording the navigation data.

Wait for the start delay.

Mask the triggers.

Wait for the first PPS to star the image data recording.
Record the image files.

SANRA o

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
» Create the image hdr file.

7. Wait for the stop delay.

Stop recording the navigation data.

9. Record the dark data.

*®

* Re-open the image file.
* Close the shutter.
* Record the dark data at the end of the image raw file until all scripted frame got recorded.
* Open the shutter.
» Update the image hdr file.
10. Record the cool (T1) thermal image.

*  Move the T1 blackbody under the fore objective.
»  Wait for T1 temperature to stabilize.
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* Record the T1 image raw file until all scripted frame got recorded.

* Create the T1 image hdr file.
11. Record the warm (T2) thermal image.

* Move the T2 blackbody under the fore objective.
»  Wait for T2 temperature to stabilize.

* Record the T2 image raw file until all scripted frame got recorded.

* Create the T2 image hdr file.
12. Home the blackbodies to allow imaging the scene again.
13. Create the metadata.
14. Create the image thumbnail.

15. Extract the radiometric calibration frame, if available, and place a copy in the dataset.

16. Create the manifest and close the dataset.

17. Queue the dataset in Lumo FileTransfer Server.
18. Update the metadata if required.

19. Update the name generator if required.

Thermal Images

The Thermal Images recording workflow will create a dataset which will contain the image data files with the dark
data added at the end of the image raw file, thermal images, metadata information, manifest and thumbnail.

B Note: This workflow is dedicated for thermal sensors in airborne systems.

The workflow steps are:
1. Open the dataset.

* Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
2. Record the cool (T1) thermal image.

* Move the T1 blackbody under the fore objective.
*  Wait for T1 temperature to stabilize.

* Record the T1 image raw file until all scripted frame got recorded.

* Create the T1 image hdr file.
3. Record the warm (T2) thermal image.

* Move the T2 blackbody under the fore objective.
»  Wait for T2 temperature to stabilize.

* Record the T2 image raw file until all scripted frame got recorded.

* Create the T2 image hdr file.

Home the blackbodies to allow imaging the scene again.
Create the metadata.

Create the image thumbnail.

Create the manifest and close the dataset.

. Queue the dataset in Lumo FileTransfer Server.
10. Update the metadata if required.

11. Update the name generator if required.

L XA NR

Extract the radiometric calibration frame, if available, and place a copy in the dataset.
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Thermal Images with Embedded Dark

The Thermal Images with Embedded Dark recording workflow will create a dataset which will contain the image
data files with the dark data added at the end of the image raw file, thermal images, metadata information, manifest
and thumbnail.

= Note: This workflow is dedicated for thermal sensors in airborne systems.

The workflow steps are:
1. Open the dataset.

» Save the current time.

* Create the dataset name.

* Create the dataset folder structure.
2. Wait for the start delay.
Mask the triggers.
4. Record the image files.

w

* Record the image raw file until the operator stops the recording or the all scripted frame got recorded.
* Create the image hdr file.

5. Wait for the stop delay.

6. Record the dark data.

* Re-open the image file.
* Close the shutter.
* Record the dark data at the end of the image raw file until all scripted frame got recorded.
* Open the shutter.
» Update the image hdr file.
7. Record the cool (T1) thermal image.

* Move the T1 blackbody under the fore objective.
»  Wait for T1 temperature to stabilize.
* Record the T1 image raw file until all scripted frame got recorded.
* Create the T1 image hdr file.
8. Record the warm (T2) thermal image.

* Move the T2 blackbody under the fore objective.
»  Wait for T2 temperature to stabilize.
* Record the T2 image raw file until all scripted frame got recorded.
* Create the T2 image hdr file.
9. Home the blackbodies to allow imaging the scene again.
10. Create the metadata.
11. Create the image thumbnail.
12. Extract the radiometric calibration frame, if available, and place a copy in the dataset.
13. Create the manifest and close the dataset.
14. Queue the dataset in Lumo FileTransfer Server.
15. Update the metadata if required.
16. Update the name generator if required.
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Plugins Manager

Overview

Lumo plugins are software extension modules that provide custom functionality, which the application itself does not
support. A plugin always consists of a single master ./ua file that contains the necessary interface required for a Lumo
plugin. A plugin can also load other ./ua files or C libraries, if needed. The master ./ua file is loaded from the Lumo
application's Plugins manager.

Using Plugins
This section describes how to use Lumo plugins.
The basic controls for Lumo plugins include:
» Loading Plugins
*  Unloading Plugins
* Enabling Plugins
* Disabling Plugins
» Changing Parameters
A more detailed description of Lumo plugins can be found in Overview.

Proceed as follows:

1. Open the Plugins section of the Setup View.
2. Load a new plugin by selecting Add plugin, and locate the plugin /ua file.
3. Modify the plugin parameters, if needed.
All plugins do not necessarily provide custom parameters.
4. Enable the plugin by selecting the Power button.
The button lights up if the plugin is enabled.
5. The plugin is now enabled and running.

The plugin interface provides functionality for the plugin to provide a scrolling progress bar to the Plugins section
whenever it is processing a task.

6. Lumo Plugin Manager remembers the state of each plugin between application restarts - an enabled plugin will
be automatically enabled after a restart.

Loading Plugins
This section describes how to load a Lumo plugin.

The controls for loading a Lumo plugin are located in the Plugins section of the Setup View (see Using Plugins).
All loaded plugins will be listed in this section after being successfully loaded. The loaded plugins are Disabled by
default, and you must enable them before use (see Enabling Plugins).

Proceed as follows:
1. Open the Plugins section of the Setup View.
2. Select Add plugin.
3. Locate the master ./ua file related to the plugin.
Usually, plugins are placed in separate sub-folders within the plugins folder of a Lumo application.
4. Select Open after finding the correct plugin.
If a plugin is loaded successfully, it will be added to the list of loaded plugins.

Unloading Plugins
This section describes how to unload a Lumo plugin.
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The controls for unloading a Lumo plugin are located in the Plugins section of the Setup View (see Using Plugins).
All loaded plugins are listed in this section, and can be separately unloaded. If a plugin is Active while being
unloaded, it is first disabled by the Lumo Plugins Manager and only then unloaded.

Proceed as follows:

1. Open the Plugins section of the Setup View.
2. Find the correct plugin from the list of all available plugins.
3. If you want to forcefully unload the plugin, regardless of its current state, select X.

To gracefully unload plugins, always wait for the plugin to stop processing by making sure the progress bar is not
active on the plugin.

4. After a plugin has been successfully unloaded, it is removed from the list of loaded plugins.

Enabling Plugins
This section describes how to enable a Lumo plugin.

The controls for enabling a Lumo plugin are located in the Plugins section of the Setup View (see Using Plugins). The
loaded plugins are disabled by default, and you must enable them before use.

The different states for an enabled plugins are:

* Waiting — Refers to a state where the plugin is waiting for either a device to be ready for usage, or an event to be
triggered, until the plugin enters the Active state.

* Active — Refers to a state where the plugin is currently running. Depending on the plugin logics, the plugin can
be idle or processing which is indicated by a scrolling progress bar next to the Active indicator.

* Error — Refers to an error state, which usually indicates an error within the plugin code. In the case of an error,
an error string is shown in the Extended view of the plugin.

Proceed as follows:

1. Open the Plugins section of the Setup View.
2. Find the correct plugin from the list of all available plugins.
3. Check the state of the Power button for the plugin and if the button is not lit, select it to enable the plugin.

If a plugin is successfully enabled, it will change its Disabled state to either Waiting or Active, depending on the
plugin implementation. In the case of an error, the state changes to Error.

Disabling Plugins
This section describes how to disable a Lumo plugin.

The controls for disabling a Lumo plugin are located in the Plugins section of the Setup View (see Using Plugins).
Disabling an plugin immediately stops any running plugin processes.

Proceed as follows:

1. Open the Plugins section of the Setup View.

2. Find the correct plugin from the list of all available plugins.

3. Check the state of the Power button for the plugin, and if the button is lit, select it to disable the plugin.
A successfully disabled plugin will automatically change its state to Disabled.

Changing Parameters
This section describes how to change Lumo plugin parameters.

The controls for changing Lumo plugin parameters are located in the Plugins section of the Setup View (see Using
Plugins). When a plugin is loaded, it can generate plugin specific parameters to the Plugins section. These parameters
can then be used by the plugin when processing, for example, when choosing the processing output data type from
the GUI, which then refers to the data output of the plugin. These parameters can be shown or hidden, by using the
triangle toggle button in the Plugins section. You can change the plugin parameters regardless of the plugin state.

Proceed as follows:
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Open the Plugins section of the Setup View.
Find the correct plugin from the list of all available plugins.

Select triangle to show the plugin parameters.

Col ol

Modify the desired parameters.

ENVI Header File Keyword Summary

This section provides a summary for ENVI header file keywords.

File description

ENVI identifier string for ENVI file format header
description image description string
file type ENVI-defined file type, check filetype.txt

Sensor description
sensor type sensor identifier string

GPS/IMU and timing information

acquisition date data file acquisition date, mm-dd-yyyy

GPS Start Time start time of GPS/IMU data recording

GPS Stop Time stop time of GPS/ IMU data recording

GPS Starting point starting location of GPS/ IMU data recording

GPS Ending point stopping location of GPS/ IMU data recording

NavSync Timing = {XXXX, YYYY} XXXX delay in [ms] before the first NavSync message

#999 was read in the navigation data stream after
the data acquisition started

YYYY NavSync time read from the sync message #999
NavSync Extra the number of extra sync messages in the navigation data
qpfTiming = {XXXX, YYYY} XXXX delay measured by query performance timer in

[ms] before the first image frame is acquired for the
frame grabber

YYYY Measured flight line data acquisition time in [ms]
First sensor or dual sensor settings (In AisaFENIX sensor1=VNIR)

fps_set set data acquisition frame rate

fps true data acquisition frame rate

fps_qpf frame rate estimated by the QPF timer

sensorid sensor serial number

tint1 integration time set to sensor

binning = {X, Y} X sensor spectral total binning (HW+SW)
Y sensor spatial total binning (HW+SW)

hw_binning = {X, Y} X sensor spectral hardware (HW) binning
Y sensor spatial hardware (HW) binning

sw_binning = {X, Y} X sensor spectral software (SW) binning
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vroi = {Y1, Y2}
hroi = {X1, X2}
vimg = {Y1, Y2}

himg = {X1, X2}

fodis = {X1, X2}
temperature = {t1,t2,t3,t4}

Y sensor spatial software (SW) binning
full spectral vertical region of interest
full spatial horizontal region of interest

sensorl spectral image area for CaligeoPRO to process, subset of
vroi

sensorl spatial image area for CaligeoPRO to process, subset of
hroi

sensorl spatial pixel range used by fodis sensor

sensor specific temperatures (t1-t4) for up to 4 points.

Second sensor settings (In AisaFENIX sensor2=SWIR)

sensorid2
tint2
binning2 = {X, Y}

hw_binning2 = {X, Y}

sw_binning2 = {X, Y}

vimg2 = {Y1, Y2}

himg2 = {X1, X2}

fodis2 = {X1, X2}
Spectral band information

default bands = {R, G, B}

wavelength
fwhm
Image data information

header offset

data type

second sensor serial number

integration time set to sensor2

X sensor2 spectral total binning (HW+SW)
sensor2 spatial total binning (HW+SW)
sensor2 spectral hardware (HW) binning
sensor2 spatial hardware (HW) binning

sensor2 spectral software (SW) binning

<X <X

sensor2 spatial software (SW) binning

sensor2 spectral image area for CaligeoPRO to process, subset of
vroi

sensor2 spatial image area for CaligeoPRO to process, subset of
hroi

sensor2 spatial pixel range used by fodis sensor

default band numbers for R, G, and B channels in ENVI images

if only one number is given, used as a gray scale channel

center wavelength values for each band in the image

full-width-half-maximum values for each band in the image

number of bytes used for embedded header information before
image data in data file

1 8-bit byte

16-bit signed integer

32-bit signed long integer

32-bit floating point

64-bit double-precision floating point

2x32-bit complex

O N n A~ WD

2x64-bit double-precision complex

12 16-bit unsigned integer
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13 32-bit unsigned long integer
14 64-bit signed long integer
15 64-bit unsigned long integer
byte order 0 least significant byte first
| most significant byte first
interleave data file interleave format: BSQ / BIP / BIL
lines number of image frames in data file
bands number of spectral bands in the image frame
samples number of spatial pixels in the image frame
X start x-coordinate of the upper-left corner pixel
y start y-coordinate of the upper-left corner pixel
autodarkstartline starting line of the acquired dark frame in the end of data file
eITOrS none no dropped frames, that is, no .log file
recover frames dropped, data recoverable
terminal frames dropped, unable to recover

GPS / Scanner Interface

Position and 1PPS information are received from the GPS unit. The 1PPS pulse is used to measure the nav sync —
timing message. The nav sync —timing value is inserted to the GPS data flow, and data is forwarded to the PC through
the USB interface (RS232 virtual serial port).

When the nav sync timing measurement is started:

» The trigger pulse state is saved.

» Trigger pulses are counted.

» The time delay between the falling edge of the 1PPS and the rising edge of trigger! pulse is measured, and saved
to the register.

* Nav sync-timing message is generated and sent to PC.

» The insertion place is detected when a quite time is detected in GPS data line.

The same GPS interface can also be used with the scanner unit. When a time-stamp measure is not started, the 1PPS

line is ignored, and the incoming RS232 line from the GPS/Scanner is directly connected to the PC without any nav
sync timing function.

The PC interface is implemented by a USB. The PC receives GPS messages and timing information through the USB
interface. Messages from PC to GPS are transparent to the FPGA.

1 Word4 bit(0) state
' Trigger Counter

0 o o0s1 2 3 4 5 6 7 8 9 10 0 0

)/Nav Sync time, resolution 0.1ms /Nav Sync time, resolution 0.1ms

I I I

Figure 31: NavSync Diagram
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Table 3: Nav Sync — Timing Message

# Example Meaning

Wordl 0x81FF sync

Word2 0x03E6 Message id #998

Word3 0x0002 Data word count: 2

Word4 0x800x Flags, assuming no errors, last bit: trigger state beginning of
measurement

Trigger pulse is low when measure is started = 0x8000

¢ 0x8...=no errors

Trigger pulse is high when measure is started = 0x8001

¢ 0x8... =no errors

Word5 Oxhhll Header check sum

Word6 Oxtttt 16-bit delay, resolution 0.1 ms
Word7 Oxnnnn 16-bit trigger counter

Word8 Oxhhll Data check sum

Message is sent low byte first, high byte after that.

Table 4. Check Sum Values

Header check sum High byte (hh) MSB(wordl) XOR MSB(word2) XOR ... MSB(word4)
Header check sum Low byte (11) LSB(wordl) XOR LSB(word2) XOR ... LSB(word4)
Data check sum High byte (hh) MSB(word6) XOR MSB(word7)

Data check sum Low byte (11) LSB(word6) XOR LSB(word7)

Configuring the SCB GPS Parameters

This section describes how to configure the SCB GPS parameters.

Multiple acquisition computers can share the same camera trigger pulses, GPS data and PPS signals. This is done
through chaining the Sensor control boards. This requires linking the acquisition computers with chaining cables via
the Chain In and Chain Out ports, and configuring the software to match the hardware setup. The following steps
guide you through configuring the software.

Proceed as follows:

1. Locate the SCB widget in Setup ViewSCB X, where X refers to the GPS index.
2. Set the Chaining mode
The chaining mode needs to match the Chain In/Chain Out cabling configurations of the acquitision computers.

1. On the computer with the GPS unit, the chaining cable is connected to the Chain out connector. Set the
Chaining mode also to Chain out from dropdown menu.

2. If there are more than two computers in the setup, then chaining cables are connected to both Chain in and
Chain out ports of the computer in the middle of the chain. Set Chaining Mode to Chain in and out.

3. The last computer in the chain only has the Chain in port connected. Set Chaining Mode to Chain in.
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Glossary

B

BPR

Bad pixel replacement.

C

CCW

Counterclockwise.

CwW

Clockwise.

D

DN

Data number.

E

EMD

Earth mover's distance.

G

GPS

Global positioning system.

GUI

Graphical user interface.

H

HDR

The ENVI header file format.

HSI

Hyper spectral imager.
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INS

Inertial Navigation System.

IP

Internet Protocol

M

MMF
Memory mapped file.

N

NIC

Network interface card.

NUC

Non-uniformity correction.

Q

QA/QC

Quality assurance, quality control.

R

RAW

The camera output data format.

RGB
Red, Green and Blue.

ROI

Region of interest.

S

SATA

Serial ATA, a computer bus interface that connects host bus adapters to mass storage devices such as hard disk drives

and optical drives.
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SSD

Solid state drive.

SSP

Specim Sensor Profile.

U

URL

Uniform Resource Locator.

wW

Widget
A widget is an element of interaction in a graphical user interface (GUI), such as a button or a scroll bar.

For more information, see Attp://en.wikipedia.org/wiki/Widget %28GUI1%29.

Workflow

A sequence of steps, which can be systematically reproduced.

X

XML
Extensible Markup Language.
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Appendix

ENVI Header Files

An ENVI header file contains information required to read an image data file. The header file has the same name as
the image data file, with the file extension .hdr. The header file keywords are presented in the table below.

sensor type

sensorid

acquisition date
GPS Start Time

GPS Stop Time

GPS Starting point
GPS Ending point

NavSync Timing = {XXXX,

NavSync Extra

binning = {X, Y}

YYYY}

Header keyword Description
File description
ENVI An identifier string for the ENVI file format header.
description An image description string.
file type An ENVI-defined file type, check filetype. txt.

AISA sensor description

An AISA sensor identifier string.

An AISA sensor serial number.

GNSS/IMU information

The data file acquisition date.

The start time of GNSS/IMU data recording.

The stop time of GNSS/IMU data recording.

The starting location of GNSS/IMU data recording.
The stopping location of GNSS/IMU data recording.

*  XXXX = Delay in [ms] before the NavSync message
was read in the navigation data stream after the data
acquisition started.

*  YYYY = NavSync time read from the sync message.

The number of extra sync messages in the navigation
data.

Data acquisition information

fps The data acquisition frame rate.

tint The integration time used in the data acquisition.

tintl The same as tint for the first sensor on dual grabbing
setup.

tint?2 The same as tint for the second sensor on dual grabbing
setup.

temperature The measurement values from temperature sensors,

depends on system.

* X = Sensor spectral binning.
* Y = Sensor spatial binning.
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Header keyword Description

qpfTiming = {XXXX, YYYY} +  XXXX = Additional delay in [ms] before the first
image frame is acquired for National Instruments
grabber.

* YYYY = Flight line data acquisition time in [ms].

SLrors * none = no dropped frames
* recover = frames dropped, data recoverable
* terminal = frames dropped, unable to recover

Spectral band information

default bands = {R, G, B} The default band numbers for R, G, and B channels in
ENVI images. If only one number is given, used as a
gray scale channel.

wavelength The center wavelength values for each band in the image.
fwhm The full-width-half-maximum values for each band in
the image.

Image data information

header offset The number of bytes used for embedded header
information before image data in data file.

data type + 1=_8-bit byte
+ 2 =16-bit signed integer
+ 3 =32-bit signed long integer
* 4 =32-bit floating point
* 5= 64-bit double-precision floating point
* 6 =2x32-bit complex
* 9 =2x64-bit double-precision complex
* 12 =16-bit unsigned integer
* 13 =32-bit unsigned long integer
* 14 = 64-bit signed long integer
* 15 =64-bit unsigned long integer

byte order * 0= least significant byte first
* 1 =most significant byte first

interleave The data file interleave format: BSQ / BIP / BIL.

lines The number of image frames in data file.

bands The number of spectral bands in the image frame.

samples The number of spatial pixels in the image frame.

x start The x-coordinate of the upper-left corner pixel.

y start The y-coordinate of the upper-left corner pixel.

vroi = {Y1, Y2} The vertical region of interest, the full spectral image
area.

hroi = {X1, X2} The horizontal region of interest, the full spatial image
area.
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Header keyword Description

vimg = {Y1, Y2} The spectral image area for Caligeo to process, subset of
VIoi.

vimgl The same as vimg for first sensor on dual grabbing setup.

vimg2 The same as vimg for second sensor on dual grabbing
setup.

himg = {X1, X2} The spatial image area for Caligeo to process, subset of
hroi.

himgl The same as himg for first sensor on dual grabbing setup.

himg2 The same as himg for second sensor on dual grabbing
setup.

fodis = {X1, X2} The spatial pixel range used by fodis sensor.

fodis2 = {X1, X2} The same as fodis for second sensor on dual grabbing
setup.

autodarkstartline The starting line of the acquired dark frame in the end of
data file.

aisaOWL keywords
Image start The first band of image area.
Image stop The last band of image area.

Specim Dataset

The Specim dataset is a folder structure containing all data and calibration files related to a capture. One dataset is
created per flight line, scan or normal capture.

This structure helps with file management and simplifies tasks like batch processing.
Dataset support is implemented in all Lumo applications.
= Note:
5=
Keep the dataset original data intact. Store processed results and other files added after recording to a new
subfolder and / or files.

When adding new contents to the datasets, update the manifest.xml file to reflect the content of the
dataset.

Automatic file import can be conveniently done by giving the absolute path of the manifest.xml file. All
absolute paths for all the capture files in the dataset can be built by combining the absolute path of the dataset
folder and the relative paths parsed from the manifest.

At the root of the dataset, there are two directories, the manifest.xml file, and a thumbnail image.
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— — o e
@C_-Jv| .. v Computer » System (C:) » temp » scanner » VNIR_nil_0073 »
Organize = = Open Include in library « Share with = Burn MNew folder - [ @
N Favorites MName Date modified Type Size
. capture 2015-02-25 16:25 File folder |

4 Libraries |, metadata 2015-02-2516:25 File folder

@ Documents | manifestxml 2015-02-2516:25 XML File 1KB

J’ Music R VMIR_nil_0073.png 2015-02-2516:25 PNG image 381 KB

[ Pictures

gﬂ Subversion

B videos

1% Computer

Gh MNetwork

capture Date modified: 2015-02-25 16:25
_F l File folder

h

Figure 32: Dataset Root Folder

The Capture Folder

The capture directory contains all the data files related to one acquisition. The file extensions are:

* .hdr for the header files
» .raw for the files containing the data
* .log for the dropped frame (optional)
* .nav for navigation data

The capture directory is depicted in the figure below:

ﬂ---__‘--—_- I:IEI!E!‘
— - i . - g A
@uv| . » Computer » System (C:) » temp » scanner » VNIR_nil 0073 » capture v |44 | | Search capture pel |
— — ——— | T—— S
Organize = Include in library Share with = Burn MNew folder ==« O @
 Favorites MName Date modified Type Size
=
|| DARKREF_VMIR_nil_0073.hdr 2015-02-2516:25 HDR File 19 KB
4 Libraries |&| DARKREF_VMIR_nil_0073.log 2015-02-2516:25 LOG File 1KB
@ Documents || DARKREF_VMIR_nil_0073.raw 2015-02-2516:25 RAW File 277,263 KB
J’ Music |8 VNIR_nil_0073.hdr 2015-02-2516:25 HDR File 19 KB
|| Pictures |& | VNIR_nil_0073.log 2015-02-2516:25 LOG File 1KB
=l Subversion |&] VNIR_nil_0073.raw 2015-02-2516:25 RAW File 454,711 KB
B videos |& ) WHITEREF_VNIR_nil_0073.hdr 2015-02-2516:25 HDR File 19 KB
|| WHITEREF_VNIR_nil_0073.log 2015-02-2516:25 LOG File 1KB
1M Computer || WHITEREF_VNIR_nil_0073.raw 2015-02-2516:25 RAW File 169,131 KB
Gh Metwork
, 9 items

h

Figure 33: Capture Directory

To be able to differentiate the different capture files, prefixes are used. The files without a prefix and with the dataset

name always are the image files or the navigation data. The others are references. The prefixes are presented in the

table below:
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Table 5: File Prefixes

Prefix File type Example
none Image data * pencil 090512-080027.hdr
* pencil 090512-080027.raw
* pencil 090512-080027.1log
none GPS data * pencil 090512-080027.nav
DARKREF Dark reference files * DARKREF pencil 090512-080027.hdr
* DARKREF pencil 090512-080027.raw
* DARKREF pencil 090512-080027.1log
WHITEREF White reference files * WHITEREF pencil 090512-080027.hdr
* WHITEREF pencil 090512-080027.raw
* WHITEREF pencil 090512-080027.log
T1 Cool reference files (OWL * Tl pencil 090512-080027.hdr
sensor) * T1 pencil 090512-080027.raw
* Tl pencil 090512-080027.log
T2 Warm reference files (OWL e T2 pencil 090512-080027.hdr
sensor) * T2 pencil 090512-080027.raw
* T2 pencil 090512-080027.log

The Metadata Folder

The metadata folder contains:

* An XML file (*.xml) with the default sensor metadata as well as the user defined metadata.
*  An XML stylesheet (*.xsl) for viewing the metadata XML file in a web browser.

The metadata directory is depicted in the figure below:

r

@'Q"' . v Computer » System (C) » temp » scanner » VNIR_nil_0073 » metadata v|¢,|

Organize = Include in library Share with = Burn

r Favorites Name

| VNIR_nil_0073.xml
) Libraries ' VNIR _nil_0073.cs!
3 Documents
rJv- Music
=] Pictures
_[] Subwversion

B videos

1M Computer

ﬁ_i Metwork

2 items

MNew folder ==« O

Date modified Type Size

XML File 2KB
XSLT Stylesheet TKB

%

Figure 34: The metadata Directory
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The metadata XML File as opened in a Web browser, is depiceted in the figure below:

| S— — — -
GZ' e | Ctemphscanner\VNIR_nil_( © ~ ¢ .@ Lumeo - Scanner measurem... % i} 9a7 553

Lumo - Scanner measurement report http:/ fwww.specim.fi

Sample name: YNIR_nil_0073

Date: WWednesday, February 25, 2015
Time: 14:24:59

Error:

Short description about this measurement.

camera |

| sensor type Spectral Camera VNIR PFD
sensor id 123456789
frame rate 30
integration time 20
samples 1312
active bands 1082

\ spatial binning 1

| spectral binning 1
frames recorded 164
frames dropped 0
data format BIL

||| calibration pack

Metadata

operator Macgyver
sensor prefix VNIR

Figure 35: The Metadata XML File in a Web Browser

The metadata consists of a simple and easy-to-parse XML tree structure. The metadata XML file as opened in a text

editor, is depiceted in the figure below:
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r@{ C:\temp\scanner\VNlR_niI_m;":'\me:ad-a‘z\VN[R_n'l|_’0073rxm| - Notepad++
File Edit Search View Encoding Language Seftings Macro Run  Plugins  Window 2
cHHE GBI+ hh|ipe|ing| 22 BEISITE0DL DN EIEY =
[= VNIR_nil_0073zaml E:i|
1 <?xm]l version="1.0" encoding="UTF-8" standalone="yes"?>
2 <?xml-stylesheet type="text/xgl" href="VNIR nil 0073.xgl"?>
2 [H<properties®><header><key field="sensor type">Spectral Camera VNIR PFD</key>
4 <key field="sensor id">123456789</key>
5 <key field="frame rate">30</key>
& <key field="integration time">20</key>
7 <key field="samples">1312</key>
8 <key field="active bands">1082</key>
] <key field="spatial bimning">1</key>
10 <key field="spectral binning">1</key>
11 <key field="frames recorded">164</key>
12 <key field="frames dropped">0</key>
13 <key field="data format">BIL</key>
14 <key field="date">2015-02-25</key>
13 <key field="date text">Wednesday, February 25, 2015</key>
16 <key field="time">14:24:59</key>
17 <key field="calibration pack"></key>
18 - </header>
15 [ <userdefined><key field="sample name">VNIR nil 0073</key>
Nl 20 <key field="operator">Macgyver</key>
21 <key field="description">Short description about this measurement.</key>
22 <key field="sensor prefix">VNIR</key>
23 </userdefined>
24 -</propsrtiss>
25
eXtensible Markup Lang length: 1137  lines: 25 Ln:1 Col:1 Sel:0]0 Dos\Windows UTF-8 w/o BOM INS
b

Figure 36: The Metadata XML File in a Text Editor

Manifest File

The manifest.xml enumerates all the files in the dataset, their relative paths within the dataset, types and

extensions.
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Citempiscanner\,VNIR_nil_003 o S
e,
File Edit 5earch View Encoding Language Settings Macro Run  Plugins  Window I X
o = =] o¢ﬁ| E3| |ﬁﬂih| % 3| J{Cj|fa EELJ HIEJ|[1 L] El[14j|ﬂﬁ =
[=] manifest 2aml ﬂl
|<?x:ml version="1.0" encoding="yLf-8"2>
El<manifest>

ST I

<file type="dazkrsf" extensicn="raw">capture/DARKREF VNIR nil 0073.raw</file>

4 <file type="dazkrsf" extension="hdz">capture/DARKREF VNIR nil 0073.hdr</file>
5 <file type="whiksrsf" extension="raw">capture/WHITEREF VNIR nil 0073.raw</file>
& <file type="whiksrsf" extension="hdr">capture/WHITEREF VNIR nil 0073.hdr</file>

<file type="capture" extension="raw">rcapture/VNIR nil 0073.raw</file>
8 <file type="capture" extension="hdr">capture/VNIR nil 0073.hdr</file>

2 <file type="properties" extension="xml">metadata/VNIR nil 0073.xml</file>
10 <file type="properties" extension="xsl">metadata/VNIR nil 0073.xsl</file>
11 <file type="preview" extension="ppg">VNIR nil 0073.ppg</file>

12 -</manifest>

eXtensible Markup Lang length: 749 lines:13 Ln:1 Col:1 Sel:0]0 Dos\Windows UTF-8 w/o BOM INS

Figure 37: manifest.xml Example

The manifest file types are:

» darkref for dark reference files
» whiteref for white reference files
» capture for image files

* t1 for cool reference files

* t2 for warm reference files

» gps for navigation data file

» properties for metadata files

» preview for thumbnail file

Thumbnail

The thumbnail image is created using the RGB band set during the recording. The color scaling is done by finding the
minimum and maximum value across all pixels of the RGB bands. The image isn’t normalized and is provided for
quick identification of the dataset only.

Figure 38: Thumbnail Example
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